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Upgrading to Enterprise Developer for
Eclipse

This guide provides information on upgrading applications from earlier Micro Focus mainframe
development environments to Enterprise Developer for Eclipse. It highlights the differences between the
old and new products, and offers solutions on how to keep your application working in the same way as
before. The guide also introduces the new concepts and features of the Integrated Development
Environment.

Note:

• This documentation uses the name Enterprise Developer to refer to Enterprise Developer for
Visual Studio and Enterprise Developer for Eclipse. The full product names are used only when it
is necessary to differentiate between the two products.

Benefits of Upgrading

You get a number of important benefits by upgrading to Enterprise Developer from earlier Micro Focus
development systems or other COBOL systems.

Enterprise Developer uses a proven industry Integrated Development Environment that supports
thousands of clients for developing and deploying critical business applications. Enterprise Developer
enables unified, collaborative, and cost-effective development through rich, industry-standard tooling and
at the same time it helps minimize skills shortages, expands market reach and accelerates time-to-delivery
to meet today’s agile business requirements.

Licensing Changes
For a number of years Micro Focus used the Micro Focus License Management System on Windows and
Micro Focus License System Administration on UNIX for Net Express and Server Express.

Micro Focus now uses a standard industry technology for license management, Sentinel RMS from
SafeNet. New product releases use Sentinel RMS, as do updates to existing products.

For more on the Micro Focus Licensing Administration Tool, see Licensing in the Enterprise Developer
help.

Resolving Conflicts Between Reserved Keywords and
Data Item Names

Micro Focus continues to enhance the COBOL language, for example, by expanding the list of reserved
COBOL words and adding new keywords to it as part of new levels of the COBOL language. Each Micro
Focus release corresponds to a particular level. You can use the MFLEVEL Compiler directive to enable
Micro Focus-specific reserved words in your code and change the behavior of certain features to be
compatible with a specific level of the language.

If you use Enterprise Developer to compile applications created with an older Micro Focus product, and
these applications use data names that are now reserved keywords in Enterprise Developer, you receive a
COBOL syntax error COBCH0666 ("Reserved word used as data name or unknown data description
qualifier"). To work around this issue and continue using some of the reserved words as data names in
your source code, you can either:
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• use the REMOVE Compiler directive to remove individual keywords from the reserved words list
• set the MFLEVEL Compiler directive to a lower level which corresponds to the level your applications

are at (see the information about MFLEVEL of some Micro Focus products further down this section).
This removes all reserved keywords which have been added for levels above that level from the
reserved words list.

You can set both directives from the command line, in your source code, or in the Additional Directives
field in the project's COBOL properties.

Setting directives from the command line

To use REMOVE from an Enterprise Developer command prompt, type the following:

cobol myprogram.cbl remove(title) ;

The command above removes TITLE as a keyword from the language so you can use it as an identifier in
a COBOL program.

To use the set of reserved words that was used for Net Express v5.1 WrapPack 5, use this command line:

cobol myprogram.cbl mflevel"15" ;

Setting directives in the source code

To set either one of the directives in your source code, type the following starting with $ in the indication
area of your COBOL program:

$set remove "ReservedWord"

Or:

$set mflevel"nn"

Setting directives in the IDE

To set either one of the directives in the project's properties:

1. In the IDE, click Project > Properties > Micro Focus > Project Settings > COBOL.
2. Type MFLEVEL"nn" or REMOVE "ReservedWord" in the Additional directives field.
3. Click Apply and then OK.

Importing and Scanning Existing COBOL Code
Enterprise Developer includes a Net Express Project Import Wizard that converts Net Express projects into
Enterprise Developer projects and imports the COBOL source code into the IDE.

To import projects

The Net Express project format is not the same as the project format in Enterprise Developer for Eclipse so
it is not possible to edit Net Express projects in Enterprise Developer directly.

You can use the Net Express Project Import Wizard to convert existing Net Express projects into Eclipse
projects, and to import the COBOL source into the IDE. Click File > Import > Convert NetExpress
Projects to COBOL Projects. The wizard analyzes your Net Express project, converts it to the
appropriate project type and sets directives as needed.

To import files

In Eclipse, you import files into your project using File > Import. This automatically adds to the project all
files from the project directory, the subdirectories and from any linked directories. To prevent a file from
being compiled, right-click the file and click Build Action > Ignore.
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To set directives

In Eclipse, you can set directives on files in the file properties and on the COBOL settings page.

Recompile All Source Code
Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Enterprise Developer.

If you do not recompile, you may receive an error. The exact error depends on the operating system you
are running. The error might be similar to this, on UNIX:

ld.so.1: rts32: fatal: libcobrts.so.2: open failed: No such file or directory
Killed

You can recompile from the IDE or the command line.

Upgrading from Net Express, Server Express and
Mainframe Express

You can upgrade COBOL applications that were developed in Net Express, Server Express and Mainframe
Express to Enterprise Developer. The majority of the existing applications will continue to run in Enterprise
Developer without the need to change their code.

This guide lists the differences between Net Express, Server Express, Mainframe Express and Enterprise
Developer in the following areas:

Compiling and
building

Having created a project in Enterprise Developer, you can either use the IDE or the
command line to build.

Run-time systems There are some differences between the run-time systems supplied with Enterprise
Developer and those supplied with Net Express, Server Express and Mainframe
Express. This, however, will not affect your existing applications and they will
continue to run under Enterprise Developer - you only need to recompile the
applications from the source code with Enterprise Developer.

Run-time system
technologies

Some technologies behave differently and require some upgrade work.

Restrictions and
unsupported
features

Some features of Net Express, Server Express and Mainframe Express are not
available in Enterprise Developer. However, there are alternative techniques for
many of these features.

Editing and
debugging

Much of the Net Express, Server Express and Mainframe Express functionality for
editing and debugging is available in Enterprise Developer, but sometimes with a
different name and with a slightly different behavior. In addition there are some new
features such as background parsing, which highlights errors as you type and code
completion techniques that provide easy access to language elements, enabling
you to select and insert them simply.

Eclipse integration Enterprise Developer is integrated with the Eclipse IDE. The development
environment provides all the functionality to manage projects and debug
applications.

Applications previously built in Net Express, Server Express and Mainframe
Express can be developed and run within the Eclipse IDE.
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Summary of Differences
The majority of the applications created with Net Express, Mainframe Express or Server Express will
continue to work in Enterprise Developer without any changes. However, there are some differences
between these development systems you should consider when you upgrade to Enterprise Developer.

Compiling and Building Differences

There are several aspects of compiling and building applications that behave differently in Enterprise
Developer. You might need to change the project properties and update some of the Compiler directives
and settings that you previously used.

Output File Formats
on page 13

Each project compiles into a single file (.dll, .so or .exe), or to multiple files of
the same file type with one output file for each source file (.dll, .so, .exe, .int,
or .gnt). As well as an .lbr file, which contains a collection of .int and .gnt files on
Windows, you now can use a .dll as the container for application components.

Compiler Directives
on page 13

When you upgrade your source code to Enterprise Developer some Compiler
directives that were specifically designed for 16-bit systems now produce an
error on compilation because they are no longer relevant. You should remove
them from your code and directives files before you compile.

Linking on page 14 The static run-time system and the single-threaded run-time system on
Windows are no longer required and they are not shipped with Enterprise
Developer. Applications built with Enterprise Developer are now linked to the
shared or dynamic run-time systems. On UNIX, you can link to the single-
threaded or multi-threaded shared or dynamic run-time system.

Called Programs and
Dependencies on
page 14

At run time, called programs are found in the same way as before. However,
there are some new ways to set COBPATH and copy files into a common
folder.

File Handler on page
15

The File Handler .obj files are not available in Enterprise Developer. Enterprise
Developer uses the File handler packaged in the mffh.dll file instead.

Makefile Conversion
on page 15

You cannot use existing makefiles from Enterprise Developer for Eclipse,
although where they invoke commands supported by Enterprise Developer they
will continue to work as before.

SQL Compiler
Directive Options on
page 15

When you upgrade your SQL appplications to Enterprise Developer, some
applications could require additional SQL compiler directive options to avoid
compiler errors.

XML PARSE
Statement on page
15

In Net Express, the default setting for the XMLPARSE Compiler directive is
COMPAT, which causes the XML PARSE statement to return information and
events for IBM Enterprise COBOL Version 3. In Enterprise Developer, the
default is XMLPARSE(XMLSS), which returns information and events for IBM
Enterprise COBOL Version 4.

Run-Time System Differences

There are some differences between the run-time systems supplied with Enterprise Developer and those
supplied with Net Express, Server Express and Mainframe Express. These, however, do not affect your
existing applications if you recompile them from the source code in Enterprise Developer.

OpenESQL on page 16 Enterprise Developer sets the BEHAVIOR SQL Compiler directive option
to MAINFRAME by default to provide optimal performance. To revert to the
default behavior exhibited in Net Express, set the BEHAVIOR directive to
UNOPTIMIZED.
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Single-Threaded Run-Time
System on page 16

The single-threaded run-time system is not available in Enterprise
Developer on Windows. Instead, both single-threaded and multi-threaded
applications run using the multi-threaded run-time system. This has no
effect on your existing applications. On UNIX, the single-threaded run-time
system is available, so that applications can link with third-party code.

Static-Linked Run-Time
System on page 16

The static-linked run-time system is not available in Enterprise Developer.
Instead, you now link native code to the shared or dynamic run-time
system. This has no effect on your existing applications.

Setting the environment on
UNIX on page 16

You use the cobsetenv script to set your COBOL environment on UNIX.

Enterprise Developer Co-
existing with Earlier Micro
Focus Products on page
16

Some additional configuration is required to ensure Enterprise Developer
andStudio Enterprise Edition work properly when installed on the same
machine.

Restrictions and Unsupported Features

Some features in earlier Micro Focus products are not available in Enterprise Developer. However there
are alternative techniques for many of these features.

CBL2XML Utility on page
16

The CBL2XML utility is currently available as a command line tool only.

COBOL Services as Java
and Web Services on
page 16

COBOL services, such as Java interfaces and Web Services, created with
the Interface Mapping Toolkit in Net Express or Server Express run only
under Enterprise Server within Micro Focus Server. They do not run under
Enterprise Server.

CSBIND on page 17 CSBIND is a service package in Net Express, Server Express and
Application Server that supports client/server COBOL applications. It is not
available in Enterprise Developer.

DBMS Preprocessors on
page 17

Earlier Micro Focus products supported DBMS preprocessor versions that
are not supported in Enterprise Developer. For a list of currently supported
DBMS preprocessors, see the Database Access Support with Native
COBOL topic.

Dialog System on page
17

Dialog System applications are not supported in Eclipse but you can
upgrade the non-GUI components of an application to Eclipse, and then
recreate the GUI components using the GUI tools in Eclipse.

Form Designer on page
17

Form Designer is the Net Express tool for creating user interfaces for CGI-
based Internet and intranet applications. Form Designer and the HTML
page wizard are not available in Enterprise Developer.

GNT Analyzer on page
17

GNT Analyzer is not available in Enterprise Developer. It has been replaced
by Test Coverage.

Host Compatibility Option
(HCO) on page 17

Mainframe Express provided a user interface for the Host Compatibility
Option (HCO) feature. This user interface is not available in Enterprise
Developer; however the HCO Create Database, DDL Processor, DCLGEN,
Export Data, and Import Data tools are available via batch command line
invocation.

INTLEVEL Support on
page 17

The INTLEVEL directive is rejected by the Compiler in Enterprise
Developer.

NSAPI on page 17 There is no support for NSAPI in Enterprise Developer.

8 | Upgrading to Enterprise Developer for Eclipse



Online Help System on
page 17

Net Express provided the Online Help System for creating online help from
character-based applications, and displaying it on screen. It is not available
in Enterprise Developer and the Online Help System information file type
(.HNF) is not supported.

OpenESQL on page 17 In both Net Express and Studio Enterprise Edition, support is provided for
Oracle OCI in OpenESQL. Enterprise Developer does not support Oracle
OCI in OpenESQL.

Secure Sockets Layer
(SSL) on page 17

Secure Sockets Layer (SSL) is a standard mechanism for sending and
receiving electronic communications in encrypted form. It is not currently
supported in Enterprise Developer.

SQL Option for DB2 on
page 17

In the Mainframe Express and Net Express IDEs, you could invoke SQL
Option for DB2 from the main menu within the IDE. For Enterprise
Developer, SQL Option for DB2 is not available from the main menu in the
IDE. Instead, all SQL Option for DB2 tools are available from Start > All
Programs > Micro Focus Enterprise Developer > Data Tools > SQL
Option for DB2.

TX Series The IBM TX Series product used to interface with Websphere in Net
Express is not supported in Enterprise Developer.

Run-Time Technology Differences

Some technologies behave differently in Enterprise Developer and this might affect how you upgrade
existing applications.

File Handling on page
18

The way you integrate your own security modules into Fileshare has changed.
Also, the FILEMAXSIZE setting is different for Enterprise Developer and for Net
Express and Server Express .

Java and COBOL on
page 18

The cobsje script is not available in Enterprise Developer for Eclipse on UNIX.
Enterprise Developer uses the COBOL run-time system to load JVM based on
LIBPATH, LD_LIBRARY_PATH, SHLIB_PATH, JAVA_HOME etc.

Test Coverage on
page 18

Enterprise Developer supports Test Coverage from the command line only.

Editing and Debugging Differences

Much of the edit and debug functionality in Net Express, Mainframe Express and Server Express is
available in Enterprise Developer, but some of it has a different name or slightly different behavior. In
addition there are some new features such as background parsing.

Interface Mapping
Toolkit on page 19

In Enterprise Developer for Eclipse, the interface mapping toolkit is available
in an initial form.

Program Breakpoints
on page 19

Program breakpoints are breakpoints that stop execution each time a
specified program or entry point within the program is called. They are
supported in Enterprise Developer.

Remote Debugging on
page 19

The Net Express animserv utility used for debugging programs remotely has
been replaced by cobdebugremote (or cobdebugremote64 when
debugging 64-bit processes) in Enterprise Developer.

Source Pool View on
page 19

The source pool view in Net Express showed all source files available in the
project directory, regardless of whether or not they are used in the current
build type. This view is not available in Enterprise Developer.
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Backward Compatibility with Earlier Micro Focus
Products
COBOL applications developed and built using previous Micro Focus products can be developed and built
with Enterprise Developer. However, there are some differences in behavior and in terminology.

Executables requiring recompilation

If you are on the AIX platform, due to an internal change, you must recompile and/or relink your programs
to make them compatible with this run-time system.

Backward Compatibility with Studio Enterprise Edition

Copybook
name
changes

A number of COBOL copybook files that were part of Studio Enterprise Edition had names
in uppercase, whereas, in Enterprise Developer, most copybooks are provided with
lowercase names.

This affects the following copybooks - DFHAFCD, IDADDSA, IDADTCA, IDAS99RB,
IDAS99TU, IEESMCA, IEFJFCBN, IEFJSSIB, IEFTIOT1, IEZJSCB, IHAACEE, IHAASCB,
IHAASVT, IHAASXB, IHACDE, IHAPSA, IKJTCB, MFJCTLBC, MFJDCUSR, MFJDSXIT,
MFJDXIT, MVSFINDM, MVSGETCT, SPOOLHK.

If your code refers to any of these files in uppercase, and you are compiling with Enterprise
Developer on UNIX, this may result in the code failing to compile, because it cannot locate
the copybooks.

You can work around this issue in on of the following ways:

1. Change the names of the copybooks referred to from your code to lowercase.
2. Create copies of the copybooks, and save them with uppercase names.
3. Set up symbolic links to point the uppercase names to their lowercase equivalents as

follows:

a. Create a script file, copylink.sh, which creates symbolic links for the above
copybooks.

b. Paste the following contents into the file:

ln -s dfhafcd.cpy   DFHAFCD.CPY
ln -s idaddsa.cpy   IDADDSA.CPY
ln -s idadtca.cpy   IDADTCA.CPY
ln -s idas99rb.cpy  IDAS99RB.CPY
ln -s idas99tu.cpy  IDAS99TU.CPY
ln -s ieesmca.cpy   IEESMCA.CPY
ln -s iefjfcbn.cpy  IEFJFCBN.CPY
ln -s iefjssib.cpy  IEFJSSIB.CPY
ln -s ieftiot1.cpy  IEFTIOT1.CPY
ln -s iezjscb.cpy   IEZJSCB.CPY
ln -s ihaacee.cpy   IHAACEE.CPY
ln -s ihaascb.cpy   IHAASCB.CPY
ln -s ihaasvt.cpy   IHAASVT.CPY
ln -s ihaasxb.cpy   IHAASXB.CPY
ln -s ihacde.cpy    IHACDE.CPY
ln -s ihapsa.cpy    IHAPSA.CPY
ln -s ikjtcb.cpy    IKJTCB.CPY
ln -s mfjctlbc.cpy  MFJCTLBC.CPY
ln -s mfjdcusr.cpy  MFJDCUSR.CPY
ln -s mfjdsxit.cpy  MFJDSXIT.CPY
ln -s mfjdxit.cpy   MFJDXIT.CPY
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ln -s mvsfindm.cpy  MVSFINDM.CPY
ln -s mvsgetct.cpy  MVSGETCT.CPY
ln -s spoolhk.cpy   SPOOLHK.CPY

c. As superuser, execute the script in the folder which contains the copybooks
($COBDIR/cpylib).

Calling RM/COBOL
compatible library
routines

Previously, to call an RM/COBOL compatible library routine, you had to set the
DIALECT"RM" Compiler directive, which ensured the correct call-convention was
used. To set this functionality now, you must explicitly use the correct call-
convention in the CALL statement.

ILREF Previously, you could specify .jar files and other formats as a parameter when using this
Compiler directive. Now, you can only specify .class files.

ILUSING If you set this Compiler directive using the $set command, the imported namespace is only
applicable to programs, classes and referenced copybooks in that file. If you set the directive
through the IDE or from the command line, the imported namespace is applicable to all
programs and classes in the project or specified on the command line.

FLAGCD This Compiler directive is no longer available in Enterprise Developer. Remove it from your
code, otherwise you receive a COBCH0053 Directive invalid or not allowed here
error.

CALLFH If your code specifies the ACUFH parameter, it may now produce adverse effects when used.
You should replace it with the methods described in Configuring Access to Vision Data Files or
Configuring Access to RM/COBOL Data Files. Both of these methods offer a fuller-functioning
solution to handling these types of data files.

Compatible
ACUCOBOL-GT file
handling
environment
variables

The following environment variables, introduced for ACUCOBOL-GT compatibility,
have been replaced with other environment variables or configuration options that
you add to your File Handler configuration file. No other ACUCOBOL-GT file
handling environment variables are supported.

Redundant variable Replaced with

FILE_CASE FILECASE configuration option

FILE_PREFIX COBDATA environment variable

FILE_SUFFIX FILESUFFIX configuration option

APPLY_FILE_PATH n/a

FILE_ALIAS_PREFIX dd_ mapping

Setting these environment variables will have no effect.

Backward Compatibility with the Net Express and Mainframe Express IDE

The main differences between the Net Express, Mainframe Express and Eclipse IDEs are:

• Perspectives. The COBOL perspective shows the views and menus relevant to COBOL development,
such as the COBOL Explorer, Program Outline, Outline and Console views. There are other
perspectives for Debugging, the Interface Mapper and CTF.

• Project > Build automatically. Whenever changes to a resource are saved, an incremental build
starts, which rebuilds all the resources modified since the last build. You can force a rebuild by using
Project > Clean.

• Build settings. These are available in three places:
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• Project > Properties > Micro Focus > Project Settings. You can specify any additional directives
to be passed to the compiler at build time. These settings do not depend on the active build
configuration and are always passed to the compiler.

• Project > Properties > Micro Focus > Build Configurations. You can have multiple build
configurations for different build scenarios and swap between them. You choose the configuration
you want to use, by setting it as the current active configuration. This then overrides the project
language settings.

• Properties on the context menu for a single file. To set this, right-click the COBOL file in the COBOL
Explorer pane. The settings are specifically for this file and they override the currently active build
configuration and the Project Language Settings.

• Debug and run configurations. You need one of these before you can debug or run a program. They are
available from:

• Project > Properties > Micro Focus > Run-time Configuration. These are the run-time settings
for this project, such as run-time arguments, run-time tunables, COBOL switches and so on.

• Run > Debug Configurations. Like build configurations, you can have multiple debug
configurations and swap between them. These override the project run-time configuration.

• Run > Run Configurations. These behave in the same way as debug configurations, but provide
slightly different options.

• Cheat sheets. These are like tutorials and give step-by-step instructions on how to do a task, together
with brief explanations. See Help > Cheat Sheets > COBOL Development. There are cheat sheets to:

• Create a project to say "Hello COBOL World".
• Import existing COBOL files into Eclipse
• Debug a program

Changes in some options and files delivered with the product include:

ADIS In earlier Micro Focus products, the default location for the ADISCTRL file was $COBDIR. The
default location of the file in Enterprise Developer is $COBDIR/etc.

Default
working mode

In Server Express and in versions of Visual COBOL R4 and earlier, the default working
mode set by the COBMODE environment variable was 32-bit. With the current release of
Visual COBOL and Enterprise Developer, it is 64-bit.

Format of the index
files

In Net Express and Server Express, the default setting of the IDXFORMAT option
was 4. With the current release of Enterprise Developer, it is 8.

FILEMAXSIZE File Handler
configuration option

In Net Express and Server Express, the default setting for FILEMAXSIZE
was 4. With the current release of Enterprise Developer, it is 8.

Coexisting with Earlier Micro Focus Products

Run-time system
error due to
COBCONFIG

A run-time system error occurs if either the COBCONFIG or COBCONFIG_
environment variable is set when you run anEnterprise Developer application or when
you use Enterprise Developer to edit or create projects and the configuration file it
refers to contains entries that are not valid for Enterprise Developer.

For example, this might happen if you have Net Express or Studio Enterprise Edition
installed and either COBCONFIG or COBCONFIG_ is set for it.

To work around this issue, ensure that Enterprise Developer is not running and then
modify the configuration file by doing one of the following:

• If the invalid tunable is not needed by another application, remove it from the run-
time configuration file.
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• Add the following as the first line in the configuration file:

set cobconfig_error_report=false

• Unset COBCONFIG (or COBCONFIG_) or set it to another configuration file that
does not contain the invalid tunable for the particular session you are running in.

Licensing error due to
environment settings
(applies to Windows
environments only)

The message "Micro Focus License Manager service is not running" can occur
when you invoke a Net Express, Mainframe Express or Studio Enterprise
Edition utility from Enterprise Developer. This happens when the tool is
invoked with Enterprise Developer environment settings while it requires the
Net Express or Studio Enterprise Edition ones.

This happens when you edit files such as .dat that have a file association with
Net Express or Studio Enterprise Edition.

Compiling and Building Differences
There are several aspects of compiling and building applications that behave differently in Enterprise
Developer. You might need to change the project properties and update some of the Compiler directives
and settings that you previously used.

Output File Formats

Supported file formats - .exe and .dll

Each project compiles into a single file (.dll, .so or .exe), or to multiple files of the same file type with one
output file for each source file (.dll, .so, .exe, .int, or .gnt). As well as an .lbr file, which contains a collection
of .int and .gnt files on Windows, you now can use a .dll as the container for application components.

Building to multiple output files

Each project compiles into a single file (.dll, .so or .exe), or to multiple files of the same file type with one
output file for each source file.

Instead of an .lbr file, which contained a collection of .int and .gnt files on Windows, you now use a .dll as
the container for application components.

Your application can consist of multiple projects, each one building a single output file, with the projects
linked together so that they can access each other.

1. Click File > New > Other.
2. Expand General and click File.
3. Enter the name to use for the linked resource. You can enter an alias.
4. Click Advanced.
5. Select Link to file in the file system and browse to the file to link to. You can also click Variables and

define a path variable, so that you can link to files using a relative path.

Compiler Directives
When you upgrade your source code to Enterprise Developer some Compiler directives that were
specifically designed for 16-bit systems now produce an error on compilation because they are no longer
relevant.

The following Compiler directives are no longer relevant and we recommend that you remove them from
your code and directives files before you compile:

01SHUFFLE
64KPARA
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64KSECT
AUXOPT
CHIP
DATALIT
EANIM
EXPANDDATA
FIXING
FLAG-CHIP
MASM
MODEL
OPTSIZE
OPTSPEED
PARAS
PROTMODE
REGPARM
SEGCROSS
SEGSIZE
SIGNCOMPARE
SMALLDD
TABLESEGCROSS
TRICKLECHECK

COBOL programs that interface with Assembler modules must be compiled with the AMODE directive. The
AMODE directive was set by default in MSS; it is not set by default in Enterprise Developer.

Linking
The static run-time system and the single-threaded run-time system on Windows are no longer required
and they are not shipped with Enterprise Developer. Applications built with Enterprise Developer are now
linked to the shared or dynamic run-time systems. On UNIX, you can link to the single-threaded or multi-
threaded shared or dynamic run-time system.

Linking from the command line

You can link applications from the Enterprise Developer command prompt with the cbllink or cblnames
commands. For example, to produce an .exe file, use:

cbllink myprogram.cbl

To compile and link your code to produce a .dll file, use:

cbllink -d myprogram.cbl

With these commands, the single-threaded and static-linking options are automatically mapped onto the
multi-threaded and shared run-time systems respectively.

Linking from the IDE

To specify what to link:

1. Click Project > Properties.
2. Expand Micro Focus > Build Configurations.
3. Click Link and specify your link settings.

Called Programs and Dependencies
At run time, called programs are found in the same way as before. However, there are some new ways to
set COBPATH and copy files into a common folder.
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To build the called programs

When you build the called programs into a .dll or .so file, you can set a property to output the built file into
the same folder as the main application executable. To do this the called programs and the application
main program must be in the same project. To set this:

1. Create a project that contains the programs that are called.
2. In the project properties, expand Micro Focus > Build Configurations and click COBOL.
3. In Target Settings, select Single Native Library File.
4. Set the Output Path to the subfolder where the main application executable is output.
5. If you want to debug the .dll file together with the application, click Override COBOL project settings

and check Compile for debugging.
6. Build the project.

To set the COBPATH environment variable

Add the COBPATH environment variable to the run-time configuration, as follows:

1. In the properties of the calling application project, expand Micro Focus > Run-time Configuration >
Environment Variables.

2. Add the COBPATH variable and specify the full path to your called files.

File Handler
The File Handler .obj files are not available in Enterprise Developer. Enterprise Developer uses the File
handler packaged in the mffh.dll file instead.

If the application you are upgrading from Net Express used the File Handler .obj files, when you link your
application in Enterprise Developer the linker will emit a warning. The application will continue to operate
as before provided that you supply the mffh.dll file with it.

Makefile Conversion
You cannot use existing makefiles from Enterprise Developer for Eclipse, although where they invoke
commands supported by Enterprise Developer they will continue to work as before.

It is not possible to use or convert existing makefiles and Visual Studio MSBuild files.

SQL Compiler Directive Options
If you get errors in Enterprise Developer when compiling an object application that was created in Net
Express or Studio Enterprise Edition, recompile specifying the GEN-CLASS-VAR SQL Compiler directive
option in addition to other appropriate options.

XML PARSE Statement
In Net Express, the default setting for the XMLPARSE Compiler directive is COMPAT, which causes the
XML PARSE statement to return information and events for IBM Enterprise COBOL Version 3. In
Enterprise Developer, the default is XMLPARSE(XMLSS), which returns information and events for IBM
Enterprise COBOL Version 4.

To emulate the Net Express behavior in Enterprise Developer, specify the XMLPARSE(COMPAT)
Compiler directive option.

For a summary of the differences in event information between XMLPARSE(XMLSS) and
XMLPARSE(COMPAT), see the Special Registers topic in your Enterprise Developer documentation.

Run-time System Differences
There are some differences between the run-time systems supplied with Enterprise Developer and those
supplied with Net Express, Server Express and Mainframe Express. These, however, do not affect your
existing applications if you recompile them from the source code in Enterprise Developer.
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The changes in the run-time system are described in the following sections.

OpenESQL
Enterprise Developer sets the BEHAVIOR SQL Compiler directive option to MAINFRAME by default to
provide optimal performance. To revert to the default behavior exhibited in Net Express, set the
BEHAVIOR directive to UNOPTIMIZED.

Single-Threaded Run-Time System
The single-threaded run-time system is not available in Enterprise Developer on Windows. Instead, both
single-threaded and multi-threaded applications run using the multi-threaded run-time system. This has no
effect on your existing applications. On UNIX, the single-threaded run-time system is available, so that
applications can link with third-party code.

Static-Linked Run-Time System
The static-linked run-time system is not available in Enterprise Developer. Instead, you now link native
code to the shared or dynamic run-time system. This has no effect on your existing applications.

See Linking Native COBOL Code in the product Help.

Setting the environment on UNIX
Before you start developing applications with Enterprise Developer for Eclipse on UNIX you need to set the
environment. We recommend that you use the cobsetenv script to do this:

. /opt/microfocus/EnterpriseDeveloper/bin/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is not
compatible with C-shell or pre-XPG4 Bourne shell.

Enterprise Developer Co-existing with Earlier Micro Focus Products
If you have Enterprise Developer and Net Express or Studio Enterprise Edition installed on the same
machine, you sometimes receive a run-time system error if either the COBCONFIG or COBCONFIG_
environment variable is set when you run anEnterprise Developer application the configuration file it refers
to contains entries that are not valid for Enterprise Developer.

To work around this issue, ensure that Enterprise Developer is not running and then modify the
configuration file by doing one of the following:

• If the invalid tunable is not needed by another application, remove it from the run-time configuration file.
• Add the following as the first line in the configuration file:

set cobconfig_error_report=false

• Unset COBCONFIG (or COBCONFIG_) or set it to another configuration file that does not contain the
invalid tunable for the particular session you are running in.

Restrictions and Unsupported Features
Some features in earlier Micro Focus products are not available in Enterprise Developer. However there
are alternative techniques for many of these features.

CBL2XML Utility
The CBL2XML utility is currently available as a command line tool only.

COBOL Services as Java and Web Services
COBOL services, such as Java interfaces and Web Services, created with the Interface Mapping Toolkit in
Net Express or Server Express run only under Enterprise Server within Micro Focus Server. They do not
run under Enterprise Server.
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CSBIND
CSBIND is a service package in Net Express, Server Express and Application Server that supports client/
server COBOL applications. It is not available in Enterprise Developer.

DBMS Preprocessors
Earlier Micro Focus products supported DBMS preprocessor versions that are not supported in Enterprise
Developer. For a list of currently supported DBMS preprocessors, see the Database Access Support with
Native COBOL topic.

Dialog System
Dialog System applications are not supported in Eclipse but you can upgrade the non-GUI components of
an application to Eclipse, and then recreate the GUI components using the GUI tools in Eclipse.

Form Designer
Form Designer is the Net Express tool for creating user interfaces for CGI-based Internet and intranet
applications. Form Designer and the HTML page wizard are not available in Enterprise Developer.

In Enterprise Developer for Eclipse, you can install one of the available plug-ins to replicate these features.

GNT Analyzer
GNT Analyzer is not available in Enterprise Developer. It has been replaced by Test Coverage.

Host Compatibility Option (HCO)
Mainframe Express provided a user interface for the Host Compatibility Option (HCO) feature. This user
interface is not available in Enterprise Developer; however the HCO Create Database, DDL Processor,
DCLGEN, Export Data, and Import Data tools are available via batch command line invocation.

INTLEVEL Support
The INTLEVEL directive is rejected by the Compiler in Enterprise Developer.

An INTLEVEL of 1, 2, or 3 is no longer supported and causes compilation errors. Other values are
reserved for internal use and should not be used.

NSAPI
There is no support for NSAPI in Enterprise Developer.

Online Help System
Net Express provided the Online Help System for creating online help from character-based applications,
and displaying it on screen. It is not available in Enterprise Developer and the Online Help System
information file type (.HNF) is not supported.

OpenESQL
In both Net Express and Studio Enterprise Edition, support is provided for Oracle OCI in OpenESQL.
Enterprise Developer does not support Oracle OCI in OpenESQL.

Secure Sockets Layer (SSL)
Secure Sockets Layer (SSL) is a standard mechanism for sending and receiving electronic
communications in encrypted form. It is not currently supported in Enterprise Developer.

SQL Option for DB2
In the Mainframe Express and Net Express IDEs, you could invoke SQL Option for DB2 from the main
menu within the IDE. For Enterprise Developer, SQL Option for DB2 is not available from the main menu in
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the IDE. Instead, all SQL Option for DB2 tools are available from Start > All Programs > Micro Focus
Enterprise Developer > Data Tools > SQL Option for DB2.

TX Series
The IBM TX Series product used to interface with Websphere in Net Express is not supported in Enterprise
Developer.

Run-Time Technology Differences
Some technologies behave differently in Enterprise Developer and this might affect how you upgrade
existing applications.

File Handling
The way you integrate your own security modules into Fileshare has changed. Also, the FILEMAXSIZE
setting is different for Enterprise Developer and for Net Express and Server Express .

Using security modules

The way you integrate your own security modules (fhrdrpwd, fsseclog and fssecopn) into Fileshare
has changed.

In Enterprise Developer, you no longer relink Fileshare but you need to supply your own separate files,
which are .dll files on Windows or shared objects on UNIX. For more information, see Writing Your Own
FHRdrPwd Module, File Access Validation Module and Logon Validation Module in the File Handling
section of your product Help.

To use fsseclog and fssecopn, you need to link one or both of them into a cobfssecurity.dll or a
shared object and place on the search path. Fileshare will issue a message indicating that it has loaded
user security modules.

On UNIX, you no longer use fsclose to call Fileshare Manager. You need to use cobfsclose instead.

Sharing data files between applications built in Enterprise Developer and others built using Net
Express or Server Express

If you have applications that access the same data files, all those applications should be built with the
same FILEMAXSIZE setting. However, applications built with Enterprise Developer use a default setting of
FILEMAXSIZE=8 while those built in Net Express or Server Express use FILEMAXSIZE=4.

In Enterprise Developer you need to set the FILEMAXSIZE setting in the file handler configuration file
(EXTFH.CFG). This ensures Net Express, Server Express, and Enterprise Developer are all using the
same setting and that programs running under the Net Express or Server Express run-time systems do not
access the same files as programs running under the Enterprise Developer run-time system.

Btrieve

Btrieve is the file handling system from Pervasive Software Inc. It is not supported in Enterprise Developer.

Java and COBOL
The cobsje script is not available in Enterprise Developer for Eclipse on UNIX. Enterprise Developer uses
the COBOL run-time system to load JVM based on LIBPATH, LD_LIBRARY_PATH, SHLIB_PATH,
JAVA_HOME etc.

Test Coverage
Enterprise Developer supports Test Coverage from the command line only.

Test Coverage replaces GNT Analyzer, which was available in Server Express.
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Editing and Debugging Differences
Much of the edit and debug functionality in Net Express, Mainframe Express and Server Express is
available in Enterprise Developer, but some of it has a different name or slightly different behavior. In
addition there are some new features such as background parsing.

Interface Mapping Toolkit
In Enterprise Developer for Eclipse, the interface mapping toolkit is available in an initial form.

Program Breakpoints
Program breakpoints are breakpoints that stop execution each time a specified program or entry point
within the program is called. They are supported in Enterprise Developer.

Remote Debugging
The Net Express animserv utility used for debugging programs remotely has been replaced by
cobdebugremote (or cobdebugremote64 when debugging 64-bit processes) in Enterprise Developer.

To debug locally-developed programs on a remote machine you must start cobdebugremote (or
cobdebugremote64 when debugging 64-bit processes) before communication can be established. See
the Enterprise Developer help for more information on cobdebugremote.

To debug remotely-developed programs on a remote machine:

• If you have developed a COBOL remote project on a machine using a local Eclipse installation and a
remote UNIX machine, you use debug configurations in the same way as locally-developed projects.
However you do not need to start the cobdebugremote (or cobdebugremote64 for a 64-bit process)
or identify a port for it to listen on, merely select the remote project in the debug configuration.

• To enable remote debugging using a COBOL Application debug configuration, you need to have an X
window implementation installed and running, so that the output of a remote application running on a
UNIX machine can be viewed on your local machine. You do not need X window for other debug
configuration types.

For more information, see the section on Remote Debugging in your product help.

Source Pool View
The source pool view in Net Express showed all source files available in the project directory, regardless of
whether or not they are used in the current build type. This view is not available in Enterprise Developer.

Tips: Eclipse IDE Equivalents to IDE Features in Earlier
Products
The following table shows Mainframe Express and Net Express IDE features and their corresponding
equivalents and locations in Eclipse.

Functionality In Mainframe Express In Net Express In Enterprise Developer
for Eclipse

Project Control

Project filename *.MVP *.APP .cobolProj in Project
directory

Add file to project All files in the project
directory and its
subdirectories are
automatically part of the
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Functionality In Mainframe Express In Net Express In Enterprise Developer
for Eclipse

project. You can exclude
programs or subdirectories
from a build using the Build
Action option on the
context menu.

Copybook path Via Workgrouping By default, all directories
within a project and their
subdirectories are included
in the initial copybook
path.To make changes,
click Project > Project
Properties > Micro Focus
> Build Path and select the
Copybook Paths tab.

Build settings for the
project:

• COBOL
• CICS including BMS
• Preprocessor
• Additional Directive

ALT+F7 or click Project >
Build Setting for Project
and select the
corresponding tabs.

Right-click the project name
and select Properties, (or
click Project > Properties
from the main menu).

Execution environment
settings:

• General
• Assembler
• COBOL
• JCL

The execution environment
is Enterprise Server.

Debug settings:

• DateWarp
• Stored Procedures

DateWarp is present in the
debug launch
configurations.

Editing

Suggest Word/Content
Assist

CTRL+G CTRL+G CTRL+Space

Locate F12 (or context menu
Locate)

F12 (or context menu
Locate)

F3 (or context menu Goto
Definition)

COBOL Find CTRL+Shift+F12 (or
context menu COBOL
Find)

CTRL+Shift+F12 (or
context menu COBOL
Find)

CTRL+Shift+G (or context
menu Find References)

Compress
Tool bar compress  (or
context menu Compress)

Tool bar compress  (or
context menu Compress)

Double-click on an item to
jump to the line in the
program.

Bookmark CTRL+F2 CTRL+F2 Click Edit > Add
Bookmark.

Compiling

Single file Compile CTRL+F7 (or click check

mark )

CTRL+F7 (or click check

mark )

Right-click a program name
and select Single File
Compile.
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Functionality In Mainframe Express In Net Express In Enterprise Developer
for Eclipse

Note: This applies
to native code only.

Build

F7 (or click build ) F7 (or click build )

By default, Eclipse
automatically builds
projects to keep them up to
date. You can also build on
request. To turn off the
automatic build, click
Project > Build
Automatically.

Build All ALT+B A ALT+B A Cleaning a project forces a
rebuild. To access this,
click Project > Clean.

Debugging

Start Debugging Alt+D A Alt+D A Choose Debug or F11
Before launching the
session, create an
appropriate debug launch
configuration.

Stop Debugging Shift+F5 Shift+F5 CTRL+F2 (or context menu

Terminate) 

Restart Debugging Ctrl+Shift+F5 Ctrl+Shift+F5 From the executable in the
debug stack view, right-
click and select Relauch
from the context menu.

Run F5 F5 CTRL+F11

Step
F11 (or click step ) F11 (or click step )

F5

Step All Ctrl+F5 Ctrl+F5
Click Resume  on the
debug toolbar.

Run Thru

F6 (or Step Over )

Run Return

F7 (or Step Return )

Run to Cursor Shift+F10 (or context
menu)

Shift+F10 (or context
menu)

CTRL+R (or context menu

Run to Line )

Skip to Cursor CTRL+Shift+F10 CTRL+Shift+F10 ALT+F12, R (or Reset

Execution Point )

Skip Statement ALT+D, I or click Debug >
Skip Statement .

No equivalent. Use ALT
+F12, R (or Reset

Execution Point )
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Functionality In Mainframe Express In Net Express In Enterprise Developer
for Eclipse

Skip Return ALT+D, K or Click Debug >
Skip Return

No equivalent. Use ALT
+F12, R (or Reset

Execution Point )

Examine ' data item' Shift+F9 Shift+F9 The Variables View
automatically shows
variable values on the
current and previous lines.

Breakpoint set F9 F9 Double click in the left
margin to toggle a
breakpoint.

Conditional Breakpoint From the Breakpoints View,
select a breakpoint and edit
the properties.

Break on Data Change Via list view Via list view To set a WatchPoint,
double-click in the margin
of line containing a WS
item, or set it from the
Outline View context menu.

Upgrading from ACUCOBOL-GT
There are conceptual and behavioral differences between Enterprise Developer and ACUCOBOL-GT, part
of the Micro Focus extend® product family, and these differences can affect the way you upgrade existing
applications to Enterprise Developer.

Refer to the Compatibility with ACUCOBOL-GT section for guidance and best practice on moving your
applications to Enterprise Developer. It covers:

• Supported ACUCOBOL-GT features, including detailed information on support for compiler options and
standard library routines.

• Syntactical differences between the two COBOL dialects, including workarounds or equivalent syntax
where applicable.

• Detailed support of compatible ACUCOBOL Windowing syntax.
• Details on how to configure your applications to continue using your Vision data files.

Compatibility with ACUCOBOL-GT
The following sections describe supported ACUCOBOL-GT features and how to enable them.

Converting ACUCOBOL-GT Applications
With Enterprise Developer you can build, compile and debug ACUCOBOL-GT applications. Certain
Compiler directives are provided to enable compatibility with some of ACUCOBOL-GT's language
extensions, data files, and other behaviors.

After you have converted your application, you must run, license, and distribute your programs in the same
manner as other Micro Focus programs. There is currently no clone of the ACUCOBOL-GT runtime known
as wrun32 (Windows) or runcbl (UNIX).

This section describes the ACUCOBOL-GT compatibility features, such as how they are enabled within
Enterprise Developer, and also the potential problems you may encounter with some aspects of the
converted source code.
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Enabling ACUCOBOL-GT Compatibility
Compile your ACUCOBOL-GT source code with certain Compiler directives that enable support for
ACUCOBOL-GT syntax, data types, and other behaviors. A number of traditional ACUCOBOL-GT compiler
options are also available.

Compiler Directives for ACUCOBOL-GT Compatibility
There are a number of Compiler directives that provide compatibility with ACUCOBOL-GT. Use the
DIALECT"ACU" directive to set all of these directives at once.

By setting DIALECT"ACU" you enable certain reserved words, data type storage behavior, and more. See
ACU DIALECT setting for full details of the directives that are set.

You can set this directive in your source code directly, through the COBOL project options interface in your
IDE or from the command line.

Compiler Option Support

You can use many of the ACUCOBOL-GT compiler options when compiling, by setting then with the
ACUOPT Compiler directive. A list of the supported options is listed in this section.

Alternatively, you can compile using a clone of the ACUCOBOL-GT compiler known as ccbl.exe
(Windows) or ccbl (UNIX). This executable is located in the bin directory found here:
%ProgramFiles(x86)%\Micro Focus\Enterprise Developer . ccbl.exe (Windows) or ccbl
(UNIX) compiles to .int code unless you specify one of the ccbl's native code options, in which case it
produces .gnt code.

Setting Compiler Options
You can set the ACUCOBOL-GT compiler options by using the ACUOPT Compiler directive, or from a
command line utility.

This COBOL system supports many of the compiler options available with the ACUCOBOL-GT (Acu)
compiler. To specify these options use the ACUOPT Compiler directive along with the traditional ACU
compiler option name.

For example:

ACUOPT(-option)

Or:

ACUOPT(--option)

ACUOPT automatically sets the ACU directive, which turns on overall ACUCOBOL-GT compatibility.

NOACU or NOACUOPT are not allowed.

Alternatively, you can compile using a clone of the ACUCOBOL-GT compiler known as ccbl.exe
(Windows) or ccbl (UNIX). This executable is located in the bin directory found here:
%ProgramFiles(x86)%\Micro Focus\Enterprise Developer. ccbl.exe (Windows) or ccbl
(UNIX) compiles to .int code unless you specify one of the ccbl's native code options, in which case it
produces .gnt code.

Supported ACUCOBOL-GT Compiler Options
There are a number of ACUCOBOL-GT Compiler options supported in Enterprise Developer, which you
enable using the ACUOPT Compiler directive.

General Support Notes

Enterprise Developer supports the following ACUCOBOL-GT compiler functionality:

• Grouping of options
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• CBLFLAGS environment variable
• Replacement of @ by the base name of the source file.

The following compiler options are available:

Standard Options

The standard options enable you to control certain compile time options, such as verbose output and
renaming the object file.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition

-e This option must be followed by a file name (as the next
separate argument). When specified, this option causes
the error listing to be written to the specified file instead of
the screen. This file is removed if no errors are found.

-o This option must be followed by a file name (as the next
separate argument), which becomes the name of the
object file instead of source-name.int. This file is
removed if the compiler detects errors in the source.

-v This option has multiple applications:

• If it is the first and only option on the command line,
then the compiler runs in "Version" mode. Using -v,
you can display version information, the copyright
notice, and other information.

• Otherwise, if it is used in combination with other
options, it causes the compiler to be verbose about its
progress.

Because -v is the lead-in sequence for the video
options, this option should be specified by itself.

-w This option causes warning messages to be suppressed
(a warning condition is never a fatal compilation error).
Suppressing warning messages can be helpful when you
are converting programs from another COBOL dialect
that uses slightly different syntaxes.

-x This causes the CBLFLAGS environment variable to be
ignored.

Native Object Code Options

The native object code option enables you to execute object files that contain native instructions for select
families of processors.

The following compiler option is supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line.

Option Definition

-n The Compiler produces native code specific to the bit
arrangement and local machine. There is no support for
cross-generation of native code.
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Listing Options

The listing options enable you to control listing information generated with an object file.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line or the ACUOPT Compiler directive.

Note: The results of these options will differ from how they appear in ACUCOBOL-GT COBOL, as
they map to listing Compiler directives in Enterprise Developer.

Option Definition

-La This option maps to the ERRLIST Compiler directive.

-Lc This option maps to the XREF and RESEQ Compiler
directives.

-Lf This option maps to the COPYLIST Compiler directive.

-Li This option maps to the ERRLIST Compiler directive.

-Ll This option maps to the FORM Compiler directive.

-Lo This option maps to the LIST Compiler directive.

-Ls This option maps to the DATAMAP Compiler directive.

-Lw This option maps to the LISTWIDTH Compiler directive.

Internal Table Options

The Internal Table options available in ACUCOBOL-GT are not required in Enterprise Developer. The
following options are accepted by the compiler, but are ignored.

Option Definition

-Td Identifier and statement table — sets the maximum
number of items in each statement. The default value is
4096.

-Te Subscript statement table — sets the maximum size for
OCCURS statements. The default value is 256.

Compatibility Options

The compatibility options enable you to control the compatibility with certain other COBOL systems.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition

-Ca This option causes simple ACCEPT and DISPLAY
statements to be treated in accordance with ANSI
semantics. Specifying this option is the same as
specifying FROM CONSOLE for all simple ACCEPT
statements and UPON CONSOLE for all simple DISPLAY
statements. You can control this behavior for individual
ACCEPT or DISPLAY statements by specifying an
explicit FROM/UPON phrase.

-Ci This option sets the compiler to be compatible with
ICOBOL for certain COBOL constructs.
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Option Definition

-Cr This option sets the compiler to RM/COBOL compatibility
mode.

-Cv This option sets the compiler to IBM DOS/VS
compatibility mode.

Source Options

The source options enable you to modify the way that the Compiler treats the physical source files.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition

-Sa This causes the compiler to assume that the input source
is in the standard ANSI source format.

-Sd Setting this option causes debugging lines marked with D
in the indicator area to be treated as normal source lines
instead of comment lines. This is equivalent to supplying
the phrase WITH DEBUGGING MODE in the SOURCE-
COMPUTER paragraph.

-Sp With this option you can specify a series of directories to
be searched when the compiler is looking for COPY
libraries. This option is followed (as the next separate
argument) by the set of directories to search.

-St This option forces the compiler to use the terminal source
format.

-S1..-S9 Specifying a digit with -S uses alternate tab stops in
source files. When this option is used, tabs will be set
every # columns apart, where # is the number specified.
For example, -S4 will set tab stops at every fourth
column. Tab stops always start in column 1.

Reserved Word Options

The reserved word options enable you to override the behavior of reserved words and synonyms.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition

-Rc Allows you to change a reserved word. This option must
be followed by two separate arguments: The first is the
reserved word you want to change. The second is the
word that you want to use instead. For example,

-Rc TITLE NAME

will allow you to use "TITLE" as a user-defined word and
will cause the word NAME to be treated as the reserved
word TITLE. You may not specify a word that is already
reserved as the new reserved word. This option may be
repeated to transform multiple reserved words.
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Option Definition

-Rn Allows you to make a reserved word a synonym for
another reserved word. This option must be followed by
two separate arguments: The first is the reserved word
for which you want a synonym. The second is the word
that functions as the synonym. For example,

-Rn COMP COMP-5

causes COMP-5 to be treated the same as the reserved
word COMP. This option may be repeated to make
multiple synonyms.

-Rw This option allows you to suppress a particular reserved
word. The option must be followed (as the next separate
argument) by the reserved word you want to suppress.
This option may be repeated to suppress multiple
reserved words. This option also allows you to suppress
some non-reserved words, such as control names (for
example, entry-field and label) or property
names (for example, max-text and bitmap-
number).

Data Storage Options

The data storage options control the behavior of certain data items and how they are stored.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition

-D1 This option causes any data item whose underlying type
is binary to be stored in one byte if that data item has only
one or two digits. Normally, such a data item would be
stored in two bytes.

-D2 This option causes COMPUTATIONAL data items to be
treated as if they were declared as COMPUTATIONAL-2.
This is the default when you are using RM/COBOL
compatibility mode.

-D5 This option causes data items declared as BINARY to be
treated as if they were declared as COMPUTATIONAL-5.
This causes the values to be stored in the host machine's
native byte-ordering instead of the machine-independent
byte-ordering normally used. This option should be used
with caution, because it can lead to programs that are not
portable.

-D6 This option causes unsigned data items declared as
PACKED-DECIMAL to be treated as if they were
declared as COMPUTATIONAL-6. This saves one-half of
a byte because the compiler will not generate any storage
for the sign.

-D7 This option allows you to match one of the binary storage
conventions used by Micro Focus COBOL. That
convention is identical to the ACUCOBOL-GT -Dm
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Option Definition

convention, except that a PIC 9(7) data item (unsigned) is
stored in 3 bytes instead of 4 and a PIC 9(12) data item
(unsigned) is stored in 5 bytes instead of 6. When you
use this option, the size of a binary item is determined as
follows (the value in the table is the number of bytes
occupied by the data item):

Number of          Signed             
Unsigned 
9's in PIC         Storage            
Storage
1 - 2              1                  
1
3 - 4              2                  
2
5 - 6              3                  
3
7                  4                  
3
8 - 9              4                  
4
10 - 11            5                  
5
12                 6                  
5
13 - 14            6                  
6
15 - 16            7                  
7
17 - 18            8                  
8

-Da This allows you to specify the data alignment modulus for
level 01 and level 77 data items. Normally, level 01 and
level 77 data items are aligned on a 4-byte boundary
(modulus 4). This is optimal for 32-bit architectures. You
can specify an alternate alignment boundary by following
this option with the desired modulus. This should be
specified as a single digit that immediately follows the -
Da as part of the same argument. For example, -Da8
specifies that data should be aligned on 8-byte
boundaries, which can provide improved performance on
a 64-bit machine.

-Db This causes COMPUTATIONAL data items to be treated
as if they were declared as BINARY data items. This is
the default when you are using VAX COBOL compatibility
mode.

-DCa This selects the ACUCOBOL-GT storage convention. It is
the default setting. This convention is also compatible
with data produced by RM/COBOL (not RM/COBOL-85)
and previous versions of ACUCOBOL-GT. It also
produces slightly faster code.

-DCb This selects the MBP COBOL sign storage
convention.Note that the MBP COBOL sign storage
convention for USAGE DISPLAY directly conflicts with
that used by IBM COBOL and some other COBOLs. As a
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Option Definition

result, signed USAGE DISPLAY items in the MBP format
are correctly understood only when the program is
compiled with -Dcb. This is unlike the other sign
conventions in which the runtime can usually extract the
correct value even when a mismatched sign convention is
specified at compile time.

Also note that MBP COBOL does not have the COMP-2
storage type. The convention that ACUCOBOL-GT
implements (Positive: X"0C"; Negative: X"0D") was
chosen because MBP COBOL most closely matches the
sign storage of other COBOLs that use that convention.

-DCi This selects the IBM storage convention. It is compatible
with IBM COBOL, as well as with several others including
RM/COBOL-85. It is also compatible with the X/Open
COBOL standard.

-DCm This selects the Micro Focus storage convention. It is
compatible with Micro Focus COBOL when the Micro
Focus ASCII sign-storage option is used (this is the Micro
Focus default).

-DCn This causes a different numeric format to be used. The
format is the same as the one used when the -Dci
option is used, except that positive COMP-3 items use
X"0B" as the positive sign value instead of X"0C". This
option is compatible with NCR COBOL.

-DCr This selects the Realia sign storage convention. Sign
information for S9(n) variables is stored using the
conventions for Realia COBOL, and their conversion to
binary decimal is the same as that performed by the
Realia compiler.

-DCv This creates numeric sign formats that are compatible
with VAX COBOL. These are identical to the IBM formats,
except that unsigned COMP-3 fields place X"0C" in the
sign position, instead of X"0F". The ANSI definition of
COBOL does not state how signs should be stored in
numeric fields (except for the case of SIGN IS
SEPARATE). As a result, different COBOL vendors use
different conventions. By using the options -Dca, -Dci,
-Dcm, -Dcn, or -Dcv, you may select alternate sign-
storage conventions. Doing so is useful in the following
cases:

• If you need to export data to another COBOL system
and need to match its sign-storage convention.

• If you are importing data from another COBOL
system, and that data contains key fields with signed
data. Keys are treated alphanumerically, so if you use
the incorrect sign-storage convention, ACUCOBOL-
GT will not find a matching key when it is doing a
READ.
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The storage-convention affects how data appears in
USAGE DISPLAY, COMP-2, and COMP-3 data types.

-Dd31 This option supports data items with up to 31-digits or 16
bytes. When this option is in effect, you may use as many
as 31 X or 9 symbols in a PIC, instead of the usual 18.
The maximum number of bytes in a COMP-X or COMP-N
data item, whose picture contains only "X" symbols, is 16,
instead of the usual 8. Intermediate results are calculated
to 33 digits instead of the usual 20.

-Df This option changes the way the compiler treats data
items declared as COMP-1 and COMP-2. Some
compilers use COMP-1 and COMP-2 to specify single-
and double-precision floating-point data items.
ACUCOBOL-GT, however, assigns a different meaning to
COMP-1 and COMP-2 and uses FLOAT and DOUBLE to
specify floating-point data items.When the -Df option is
used, the compiler treats data items declared as COMP-1
as if they were declared FLOAT and data items declared
as COMP-2 as if they were declared DOUBLE. With the
-Df option, you have the following correspondence:

COMP-1   FLOAT    single precision
COMP-2   DOUBLE   double precision

The -Df option makes it easier to compile code originally
written for another compiler — one that used COMP-1
and COMP-2 to specify floating point data items. The -
Df option lets you compile such code without having to
change COMP-1 and COMP-2 to FLOAT and DOUBLE.

-Dl1/2/4/8 This option allows you to limit the maximum alignment
modulus that will be used for SYNCHRONIZED data
items. Normally, a synchronized data item is aligned on a
2-, 4-, or 8-byte boundary depending on its type. This
option allows you to specify an upper bound to the
modulus used. This is specified as a single digit that
immediately follows the -Dl as part of the same
argument. For example, -Dl4 specifies that the
maximum synchronization boundary is a 4-byte
boundary. If you want to make programs that are
compliant with the 88/Open COBOL specification, you
should specify -Dl4.

-Dm This option causes any data item whose underlying type
is binary to be stored in the minimum number of bytes
needed to hold it. Normally, binary types are stored in
two, four, or eight bytes. This option allows storage in any
number of bytes ranging from one to eight.

-Dq Causes the QUOTE literal to be treated as an
apostrophe, or single quotation mark, rather than as a
double quotation mark ("). One exception to this is the HP
e3000 TRANSFORM verb, in which QUOTE is always
treated as a double quotation mark.
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-Ds This causes USAGE DISPLAY numeric items with no
SIGN clause to be treated as if they were described with
the SIGN IS TRAILING SEPARATE clause. Several
versions of RM/COBOL behave this way (all versions
before 2.0, and some versions afterward).

-Dv This option allows you to specify the default byte (initial
value) used to initialize any data item not otherwise
initialized when the program is loaded. The option must
be followed by an equals sign (=) and the decimal value
of the byte to use (for all current platforms, this is the
ASCII value of the desired character). For example, to fill
memory with the NULL character, use -Dv=0. To fill
memory with the ASCII space character, use -Dv=32.

-Dw32 This option is checked for compatibility with the system's
bit arrangement.

-Dw64 This option is checked for compatibility with the system's
bit arrangement.

Truncation Options

The truncation options enable you to control the truncation of certain data items.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition

-Dz All binary and packed-decimal data types ignore their
PICTURE when determining the largest value they can
hold. The PICTURE is not used when moving to a
nonnumeric destination (the largest possible value
determines the number of digits moved instead).

-noTRUNC All binary data types ignore their PICTURE when
determining the largest value they can hold. However, the
PICTURE is used when moving data from a binary
number to a nonnumeric data item. The name of this
option is similar to the name used by some other COBOL
systems that behave this way.

-truncANSI Full ANSI COBOL rules are in place. Each numeric data
item stores values up to its PICTURE in size. A small
number of USAGE types provide exceptions (such as
COMP-X and COMP-5). Values larger than allowed by
the PICTURE are truncated using the standard size rules
when the data item is the target of a MOVE statement;
however, COMP-5 items do use their PICTURE when
moving a value to a nonnumeric data item. The results of
an arithmetic overflow (without the SIZE phrase) are
undefined.

Comments:

The -Dz truncation option is not supported in Managed COBOL.
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Video Options

The video options enable you to control the behavior of certain items displayed to screen.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition

-Vc This option causes any ACCEPT statement that contains
a numeric or numeric edited receiving field to be treated
as if the CONVERT phrase were also specified.

-Vd This option causes non-USAGE DISPLAY numeric items
to be converted to USAGE DISPLAY before the screen
display occurs.

This option is always on.

Warning and Error Options

The warning and error options enable you to set the error threshold before a object file will stop executing.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition

-a This flag is now obsolete and should not be used.

-Qm This option specifies the number of errors the compiler
reports before it exits. The option must be followed by a
positive numeric argument, which is the maximum
number of errors the compiler reports before it exits. The
default value is 100.

Debugging Options

The debugging options enable you to generate and execute object files suitable for debugging.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line or the ACUOPT Compiler directive.

Note: The results of these options may differ slightly from how they appear in ACUCOBOL-GT
COBOL, as they map to the debugging Compiler directives in Enterprise Developer.

Option Definition

-Ga, -Gd, -Gl, -Gs, -Gy These options map to the ANIM Compiler directive
setting.

-Gz This option maps to the NOANIM Compiler directive
setting.

Miscellaneous Options

The miscellaneous options enable you to control a number of aspects of the generated object files, such as
bounds checking and optimization.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccbl64 (UNIX) from the command line or the ACUOPT Compiler directive.
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-Za Causes the compiler to generate code to test array
references at runtime. If an index is used which is out-of-
bounds, the runtime system displays an error message
showing the index value and the allowed bounds. (This
causes some extra code to be generated and prevents
certain table optimizations from occurring, so it should be
turned off once a program is fully debugged.) With this
option, the compiler does not re-use previously computed
index values.

-Zc This compact option optimizes for smaller code instead of
faster code.

This option is accepted by the compiler, but is ignored.

-Zd Although still supported, this option has been replaced by
the -Gd option. Both options produce the same results.

-Zg Enables the use of segmentation (overlays) in the source.
If this option is not used, section numbers will be ignored.

This option is accepted by the compiler, but is ignored.

-Zi Causes the program to be compiled as if it had the IS
INITIAL PROGRAM phrase specified in its
PROGRAM-ID paragraph.

-Zl All data items may be larger than 64 KB. This option is
obsolete.

-Zn This turns off ACUCOBOL-GT's local optimizer. This is
useful primarily to see if the optimizer is introducing errors
in the generated object code. This option also prevents
the compiler from re-using previously computed index
values.

This option is accepted by the compiler, but is ignored.

-Zs Although still supported, this option has been replaced by
the -Gy option. Both options produce the same results.

-Zy This option lets you treat ACCEPT FROM DATE as
ACCEPT FROM CENTURY-DATE, and ACCEPT FROM
DAY as ACCEPT FROM CENTURY-DAY. If you use this
option, the 4-digit year format will be used for ACCEPT
FROM DATE providing that:

• The receiving field is numeric or numeric edited and
contains eight or more integer digits; or

• The receiving field is not numeric or numeric edited
and contains eight or more character positions.

If neither of the above conditions applies, then ACCEPT
FROM DATE will return its normal 6-digit format even if
you use -Zy.

-Zr0 This option tells the compiler not to allow recursive
PERFORMs. Event procedures require the ability to do
recursive PERFORMs.
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-Zr1 This option tells the compiler to allow recursive
PERFORMs. Event procedures require the ability to do
recursive PERFORMs.

32- and 64-Bit Code Generation
When compiling with the DIALECT"ACU" directive, the Compiler generates intermediate code that is bit
independent. By using ccbl, you can specify 32 or 64-bit intermediate code.

When compiling for generated code you must specify 32 or 64-bit. Enterprise Developer is bit-specific and
does not support cross-bit generation.

For UNIX environments

ccbl is sensitive to the current COBMODE setting. There are also the ccbl32 and ccbl64 commands,
which generate 32 or 64-bit code respectively. This is all analogous to cob.

For Windows environments

To produce bit-specific code, use ccbl from either a 32-bit or 64-bit command prompt.

ACUCOBOL-GT Conversion Issues

The syntax of most ACUCOBOL-GT source programs when submitted to run on this COBOL system will
be accepted and run successfully. However, sometimes this COBOL system might reject some of the
syntax in the original source program, or might cause your program to behave unexpectedly at run-time.

The following is not an exhaustive list of the restrictions of using ACUCOBOL-GT source code in
Enterprise Developer. In most cases, if your code includes ACUCOBOL-GT features not supported by
Enterprise Developer, you will receive a Compiler error.

Unsupported Features

The following features of ACUCOBOL-GT are not supported in Enterprise Developer

• The ACUCOBOL-GT multi-threading model.
• The ACUCOBOL-GT Thin Client technology.
• The Graphical Technology (GT).

Configuration Files and Configuration Variables
ACUCOBOL-GT configuration files and configuration variables are not supported in Enterprise Developer.

Enterprise Developer uses different configuration files and variables. You need to review your existing
ACUCOBOL-GT configuration to determine which settings are relevant for use and which settings have
Enterprise Developer equivalents.

For example, some configuration settings for handling Vision files can be set in the default File Handler in
Enterprise Developer.

Some ACU configuration variables are not necessary or applicable in Micro Focus COBOL (for example,
PERFORM_STACK), and the functionality of others is covered by the Micro Focus compile and run-time
options (for example, A_CHECKDIV).

Screen Descriptions
Enterprise Developer and extend® differ in their support for some of the Screen Description phrases.

In Enterprise Developer, the following phrases of the Screen Description entry are not supported and
should be removed from your programs:
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AFTER
BEFORE
EXCEPTION

Truncation Options in Managed Code
The -Dz truncation option is not supported in Managed COBOL.

It is, however, supported in native COBOL, using the ACUOPT Compiler directive.

Using Pipes to Assign Filenames When Using the Vision File Handler
When assigning filenames, you cannot use certain pipes to assign a filename in the ASSIGN clause of the
SELECT statement if you are using the Vision file handler.

The ACUCOBOL-GT syntax of assigning a file using the -P, -D, and -F syntax is not supported in
Enterprise Developer; for example:

select test-file assign to "-P %TMP% cmd /c dir *.* > %TMP%"

select test-file assign to "-P ls *"

If your applications use this syntax, you should remove it from your SELECT statements.

For more information on the pipes that are supported, read Programming > File Handling > File Handling
Guide > Filenames > Setting Up Pipes.

Using Vision Indexed Files
This COBOL development system allows you to continue to use your existing ACUCOBOL-GT data files,
including Vision indexed data files.

Alternatively, you can use the data migration tool, ACU2MFDataMigration.exe, to convert Vision data
files to Micro Focus format. The tool is available from the folder in which the product samples are installed.

Configuring Access to Vision Files

To handle Vision files, you map a file to a compatible IDXFORMAT in the File Handler configuration file.

Within the configuration file, you can map an IDXFORMAT to all files in a particular folder, all files with a
specific file extension, or a single file. See Format of the Configuration File for the tags that you can use for
the mapping, and the order in which settings in these tags are applied.

The order that the mapping is applied is important, as conflicting settings can be overwritten; for example,
the following excerpt of the configuration file sets all files in c:\files\rmfiles (Windows) or usr/
files/rmfiles (UNIX) to IDXFORMAT 21 and all files with a .DAT extension to IDXFORMAT 17:

Windows:
[FOLDER:C:\\files\\rmfiles]
IDXFORMAT=21

[*.DAT]
IDXFORMAT=17

UNIX:
[FOLDER:usr/files/rmfiles]
IDXFORMAT=21

[*.DAT]
IDXFORMAT=17

If there is a .DAT file in c:\files\rmfiles (Windows) or usr/files/rmfiles (UNIX), the mappings
are applied according to the type of tag. In the case above, mappings in the extension tag are applied after
mappings in the FOLDER tag, and so the .DAT file in that directory has an IDXFORMAT of 17.

By default, the File Handler handles all sequential and relative data files, but if you want to handle them
through the Vision file handler, use the INTEROP=ACU configuration option; however, in cases where the
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INTEROP and IDXFORMAT mappings conflict, the INTEROP setting will override IDXFORMAT for your
Vision indexed data files.

Vision Related Utilities

Vision provides a series of utilities that enable you to manipulate Vision files from the command line.

Windows Platforms:

Each utility is available in a 32-bit and a 64-bit version, located in %ProgramFiles(x86)%\Micro
Focus\Enterprise Developer\binn and \binn64 respectively.

UNIX Platforms:

Each utility is available in a 32-bit and a 64-bit version, located in $COBDIR/bin. The version executed is
determined by the COBMODE environment variable.

Commands

vutil32 (Windows) and
mfvutil (UNIX)

Rebuilds a file that has become corrupt, or one that contains a large
number of deleted records that you want to remove from the file.

vio32 (Windows) and
mfvio (UNIX)

Enables you to collect a group of files together into archives, and allows
you to extract some or all of these files from these archives.

logutil32 (Windows) and
mflogutil (UNIX)

Enables you to examine and edit an ACUCOBOL-GT transaction log file.

acusort (Windows) and
mfvissort (UNIX)

Enables you to sort or merge Vision files.

ACUCOBOL-GT Library Routines
This COBOL development system provides a number of ACUCOBOL-GT library routines in native and
managed code.

C$CALLEDBY
Returns the name of the caller of the currently running COBOL program or spaces if no caller exists or if
the caller is unknown.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "C$CALLEDBY" 
    USING CALLING-PROGRAM
    GIVING CALL-STATUS

Parameters

CALLING-PROGRAM PIC X(n)   Contains the name of the calling program or spaces if no
caller exists or if the caller is unknown. The runtime will
use as much space for the name or spaces as the
COBOL program allows. If the object being called is in an
object library, the program returns the PROGRAM-ID. If
the object is not in an object library, the disk name is
returned.

CALL-STATUS PIC S99 This parameter receives one of the following values:
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1 - Routine called by another COBOL program
0 - Routine is the main program; no caller exists
-1 - Caller unknown; routine not called by a COBOL
program

Compatibility Issues

None.

C$CALLERR
Retrieves the reason why the last CALL statement failed. For accurate information, it must be called before
any other CALL statement is executed.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "C$CALLERR" 
    USING ERR-CODE, ERR-MESSAGE

Parameters

ERR-CODE PIC X(2)

This parameter receives one of the following values:

01 Program file missing or inaccessible

02 Called file not a COBOL program

03 Corrupted program file

04 Inadequate memory available to load program

05 Unsupported object code version number

06 Recursive CALL of a program

07 Too many external segments

08 Large-model program not supported (returned only by runtimes that do not support large-model
programs)

09 Exit Windows and run "share.exe" to run multiple copies of "wrun32.exe" (returned only by Windows
runtimes)

14 Japanese objects are not supported (returned only by runtimes that do not support Japanese objects)

ERR-MESSAGE PIC X(n) (optional)   

This routine may optionally be passed a second alphanumeric parameter. This parameter is filled in with a
descriptive message about the error encountered.

Compatibility Issues

• Only ERR-CODE 01 is returned in this COBOL system.
• ERR-MESSAGE is always set to SPACES.

C$CHDIR
Changes the current working directory.
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Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "C$CHDIR" 
    USING DIR-NAME, ERR-NUM

Parameters

DIR-NAME PIC X(n) Contains the name of the new directory, or spaces.

The "@[DISPLAY]:" for Thin Client support is allowed.
For example:

C$CHDIR "@[DISPLAY]:C:\path"

In Thin Client environments, to get the current default
directory on the display host, DIR_NAME should contain
"@[DISPLAY]:" followed by spaces.

ERR-NUM PIC 9(9) COMP-4 (optional)   Holds the returned error number, or zero on success.

Comments

If a second USING parameter is passed, it must be described as PIC 9(9) COMP-4. This parameter will be
set to ZERO if the directory change is successful. Otherwise, it will contain the operating system's error
number.

If DIR-NAME contains spaces, then the current default directory is returned in it. In this case, ERR-NUM is
not used. Otherwise, DIR-NAME should contain the name of a directory to make the new default directory.
On Windows machines, this can include a drive letter. If you pass ERR-NUM, it will be set to zero if the
change was successful. Otherwise, ERR-NUM will contain the error value returned by the operating
system.

On some systems (such as VMS), it is legal to switch to a directory that does not exist, while other systems
(Windows, UNIX) do not allow it.

The behavior of this routine is affected by the FILENAME_SPACES configuration variable. The value of
FILENAME_SPACES determines whether spaces are allowed in a file name.

IMPORTANT

If you use C$CHDIR, create a CODE_PREFIX configuration entry to locate your object files. Ensure that all
of the search locations specified by the CODE-PREFIX are full path names. Do not use the current
directory or any relative path names in the CODE_PREFIX. Without a full path name, the runtime system
may be unable to find your object files if it needs to re-open them.

For example, the runtime system must occasionally re-open an object file when:

• you are using the source debugger
• the program contains segmentation (overlays)
• you are using object libraries

If the object file was initially found in the current directory or a directory specified relative to the current
directory, and you then change the current directory with the C$CHDIR routine, the runtime system will not
be able to find the object file if it needs to re-open it. This will cause a fatal error and your program will halt.

If you use C$CHDIR and you are running in debug mode, be sure to set CODE_PREFIX in the
configuration file, not in the environment. You may set CODE_PREFIX in the environment when you are
not in debug mode.
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Compatibility Issues

• In JVM COBOL, this routine is not supported.
• "@[DISPLAY]" is not supported in this COBOL system.
• The FILENAME_SPACES configuration variable is not supported in this COBOL system. To use

filenames that contain spaces, enclose them in quotation marks.
• The CODE_PREFIX configuration variable is not supported in this COBOL system.

C$COPY
Creates a copy of an existing file.

Syntax:
CALL "C$COPY"
   USING source-file, dest-file, [file-type,]
   [GIVING status]

Parameters:
source-file

PIC X(n)

dest-file
PIC X(n)

file-type
PIC X

status
Any numeric type

On Entry:
source-file

The path name of the file to be copied

dest-file
The path name of the destination file

file-type
The file organization of the source file.It must be one of: S (for sequential), R (for relative)
or I (for indexed).

This defaults to S if not specified.

On Exit:
copy-status

Returns zero if the copy is successful, or non-zero if not.

Comments:

To obtain an extended file status code for this operation, define status as comp xx comp-x and follow the
example in Extended File Status Codes.

C$DELETE
Deletes a file.
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Syntax:
CALL "C$DELETE"
   USING file-name, [file-type,]
   [GIVING status]

Parameters:
file-name

PIC X(n)

file-type
PIC X

status
Any numeric type

On Entry:
file-name

The pathname of the file to be deleted

file-type
The file organization of the filename. It must be one of: S (for sequential), R (for relative) or
I (for indexed).

This defaults to S if not specified.

On Exit:
status

Returns zero if the delete is successful, or non-zero if not.

Comments:

To obtain an extended file status code for this operation, define status as comp xx comp-x and follow the
example in Extended File Status Codes.

C$FILEINFO
Retrieves some operating system information about a given file.

Syntax:
CALL "C$FILEINFO"
   USING file-name, file-info
   GIVING status

Parameters:
file-name

PIC X(n)

file-info
Define the following group

01 file-info
  03 file-size  pic x(8) comp-x.
  03 file-date  pic 9(8) comp-x.
  03 file-time  pic 9(8) comp-x.

status
Any numeric type
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On Entry:
file-name

The name of the file

On Exit:
file-info

The group item to receive the file information

status
Returns zero if the delete is successful, or non-zero if not.

Comments:

To obtain an extended file status code for this operation, define status as comp xx comp-x and follow the
example in Extended File Status Codes.

C$GetLastFileOp
Retrieves the last COBOL I/O operation performed.

Use this library routine within a declarative procedure after an I/O error has occurred.

Syntax:
CALL "C$GetLastFileOp" USING operation

Parameters:
operation

PIC X(20)

On Exit:

operation The name of the last I/O operation performed. The valid operations returned are:

Close

Commit

Delete

DeleteFile

Open

ReadLock

ReadNextLock

ReadNextNoLock

ReadNoLock

ReadPreviousLock

ReadPreviousNoLock

Rewrite

Rollback

Start

StartTransaction

Unlock

UnlockAll

Write

Comments:

If the operation is longer than 20 characters, it is truncated to the right.

If the value SPACES is returned that indicates that no operation is available.

C$LIST-DIRECTORY
The C$LIST-DIRECTORY routine lists the contents of a selected directory. Each operating system has a
unique method for performing this task. C$LIST-DIRECTORY provides a single method that will work for all
operating systems.
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Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "C$LIST-DIRECTORY" 
    USING OP-CODE, parameters 

Parameters

OP-CODE PIC 99 COMP-X Indicates which C$LIST-DIRECTORY operation to
perform. The operations are described below.

Parameters vary depending on the op-code chosen.

Parameters provide information and hold results for the op-code specified. These parameters are
described below.

Description

C$LIST-DIRECTORY allows you to get the names of files residing in a given directory. It accomplishes this
through three distinct operations. The first operation opens the specified directory. The second operation
returns the filenames in the list, one-at-a-time. The third operation closes the directory and deallocates all
memory used by the routine. C$LIST-DIRECTORY has the following operation codes (defined in
acucobol.def):

LISTDIR-OPEN (VALUE 1)
Opens the specified directory. It has two parameters:
Directoryname PIC X(n)
Contains the name of the directory to open. This directory must exist, and you must have
permissions to read the directory. You may use remote name syntax if AcuServer is
installed on the remote machine. The "@[DISPLAY]:" for Thin Client support may be used.
For example:

C$LIST-DIRECTORY using listdir-open, 
"@[DISPLAY]:C:\path", pattern 

Pattern PIC X(n)
Specifies the type of filename for which to search. This routine supports "wildcards,"
meaning that the character "*" will match any number of characters, and the character "?"
will match any single character. For example, you can search by file suffix (*.def) or by a
common part of a file name (acu*).

If the call to LISTDIR-OPEN is successful, RETURN-CODE contains a handle to the list. The value in
RETURN-CODE should be moved to a data item that is USAGE HANDLE. That data item should be
passed as the directory handle to the other C$LISTDIRECTORY operations. If the call to LISTDIR-OPEN
fails (if the directory does not exist, contains no files, or you do not have permission to read the directory),
RETURN-CODE is set to a NULL handle.

LISTDIR-NEXT (VALUE 2)
Reads each filename from the open directory. It has two parameters:
Handle USAGE HANDLE
The handle returned in the LISTDIR-OPEN operation.

Filename PIC X(n)
The location of the next filename to be returned. If the directory listing is finished, it is filled
with spaces.

The call to LISTDIR-NEXT can include an additional argument, LISTDIR-FILE-INFORMATION (defined in
"acucobol.def"), which receives information about the returned file name. This is an optional group item
which returns information about the following data items:
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LISTDIR-FILE-TYPE
The file type can be one of the following:

B = block device
C = character device
D = directory
F = regular file
P = pipe (FIFO)
S = socket
U = unknown

LISTDIR-FILE-CREATION-TIME
The creation time is the date (and time) that the file was originally created.

LISTDIR-FILE-LAST-ACCESS-TIME
The last access time is the date (and time) that the file was last accessed by some
application (usually when the file was queried in some way).

LISTDIR-FILE-LAST-MODIFICATION-TIME
The last modification time is the date (and time) the file was last written to.

LISTDIR-FILE-SIZE
The size of the file is given in bytes.

LISTDIR-CLOSE (VALUE 3)
Releases the resources used by the other operations. It must be called to avoid memory
leaks. It has one parameter, handle, which is the same data item used by the LISTDIR-
NEXT operation.

Handle USAGE HANDLE
The handle returned in the LISTDIR-OPEN operation.

Note: Because the supported file types vary by operating system, The data items in the above list
have slightly different meanings depending on your operating system. Even on operating systems that
support these values, some file systems may not. Some versions of the UNIX® operating system may
change these values when permissions are changed. Refer to your operating system documentation
for specific definitions.

Example

The following example lists the contents of a directory with repeated calls C$LISTDIRECTORY:

WORKING-STORAGE SECTION.
copy "def/acucobol.def".
01  pattern       pic x(5) value "*.vbs".
01  directory     pic x(20) value "/virusscan".
01  filename      pic x(128).
01  mydir         usage handle.
PROCEDURE DIVISION.
MAIN.
* CALL LISTDIR-OPEN to get a directory handle.
    call "C$LIST-DIRECTORY" 
       using listdir-open, directory, pattern.
    move return-code to mydir.
    if mydir = 0
       stop run
    end-if.
* CALL LISTDIR-NEXT to get the names of the files.  
* Repeat this operation until a filename containing only 
* spaces is returned.  The filenames are not necessarily 
* returned in any particular order.  Filenames may be 
* sorted on some machines and not on others.
    perform with test after until filename = spaces
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       call "C$LIST-DIRECTORY" 
          using listdir-next, mydir, filename
    end-perform.
* CALL LISTDIR-CLOSE to close the directory and deallocate
* memory. Omitting this call will result in memory leaks.
    call "C$LIST-DIRECTORY" using listdir-close, mydir.
    stop run.

Compatibility Issues

• This routine is not supported in managed COBOL.
• You must compile with the DIALECT"ACU" Compiler directive when using this library routine.
• "@[DISPLAY]" is not supported in this COBOL system.
• Under the optional LISTDIR-FILE-INFORMATION group item, the fields LISTDIR-FILE-CREATION-

TIME and LISTDIR-FILE-LAST-ACCESS-TIME only return zeroes.

C$MAKEDIR
Creates a new directory.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

C$MAKEDIR can make a directory only one level lower than an existing directory and cannot create more
than one level at a time.

Usage
CALL "C$MAKEDIR" 
    USING DIR-NAME GIVING STATUS-CODE

Parameters

DIR-NAME PIC X(n) Contains the name of the directory to be created. This
should be either a full path name or a name relative to the
current directory. You may use remote name syntax in
combination with AcuServer to create a directory on a
remote machine.

The "@[DISPLAY]:" annotation for Thin Client support
may also be specified. For example:

C$MAKEDIR "@[DISPLAY]:C:\path"

STATUS-CODE Numeric data item. Receives the return status of the call to create a directory.
A return status of zero indicates that the directory was
successfully created; a status of one ("1") indicates
otherwise.

The behavior of this routine is affected by the
FILENAME_SPACES configuration variable. The value of
FILENAME_SPACES determines whether spaces are
allowed in a file name.

Compatibility Issues

• "@[DISPLAY]" is not supported in this COBOL system.
• The FILENAME_SPACES configuration variable is not supported in this COBOL system. To use

filenames that contain spaces, enclose them in quotation marks.
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C$MEMCPY (Dynamic Memory Routine)
Copies bytes between any two memory locations.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "C$MEMCPY" 
    USING, BY VALUE, DEST-PTR, SRC-PTR, NUM-BYTES

Parameters

DEST-PTR USAGE POINTER or USING BY
REFERENCE

Contains the address of the first byte of the destination.

SRC-PTR USAGE POINTER or USING BY
REFERENCE

Contains the address of the first byte of the source.

NUM-BYTES USAGE UNSIGNED-INT or an unsigned
numeric literal

Indicates the number of bytes to copy.

Description

This routine copies NUM-BYTES bytes of memory from the address contained in SRC-PTR to the address
contained in DEST-PTR. This routine is functionally similar to the M$COPY (Dynamic Memory Routine)
routine except that parameters are passed by value instead of by reference. This routine can be used in
cases where M$PUT and M$GET are not adequate. Note that this routine is relatively dangerous to use. It
does not perform any error checking and can easily cause memory access violations if you pass it incorrect
data. In other words, this routine is a very low-level routine and should be used cautiously.

You do not need to pass POINTER data items for SRC-PTR and DEST-PTR. If you prefer, either or both
can be replaced by a data item passed BY REFERENCE. If you do this, then the address of the data item
is passed to C$MEMCPY. For example, you can copy 10 bytes to DEST-ITEM from the memory address
contained in SRC-PTR with:

     CALL "C$MEMCPY" 
        USING BY REFERENCE DEST-ITEM, BY VALUE SRC-PTR, 10

Compatibility Issues

None.

C$MYFILE
Returns the filename of the disk file containing the currently executing program.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

This is especially useful if the disk file is an object library.

Usage
CALL "C$MYFILE" 
    USING PROGRAM-NAME 
    GIVING CALL-STATUS

Parameters

PROGRAM-NAME PIC X(n) Indicates the name of the disk file containing the currently
executing program, if known. The runtime will use as
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much space for the name of the file as the COBOL
program allows. This parameter will contain the filename
just as the runtime received it. For example, if an object
library is loaded as ../ardir/myarlib.lib, and a
program in myarlib.lib calls this routine,
PROGRAM-NAME will have a value of ../ardir/
myarlib.lib.

CALL-STATUS PIC S99. This parameter receives one of the following values:

1 - PROGRAM-NAME was filled successfully

-1 - Program name unknown

Compatibility Issues

None.

C$NARG
This routine returns the number of parameters passed to the current program.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "C$NARG" 
    USING NUM-PARAM

Parameter

NUM-PARAM COMP-1

Description

This routine must be called with one USING parameter that must be a COMP-1 data item. This data item is
filled in with the number of parameters. If the calling program is a subprogram, then this will be the number
of USING items in the CALL statement that initiated the program. If the calling program is a main program,
then this will be the number of CHAINING parameters passed from the runcbl command line or the CHAIN
statement that initiated the program. C$NARG works only when the program is a called subroutine. It does
not work with the "CALL RUN" form of the CALL verb.

Compatibility Issues

• This routine is not supported in managed COBOL.
• Set the Compiler directive COMP1(BINARY) to set ACUCOBOL-GT behavior for COMP-1 data items.
• The "CALL RUN" statement is not supported in this COBOL system.
• In ACUCOBOL-GT COBOL, the number of parameters passed is calculated by the number of

parameters specified in the USING phase of the CALL statement in the calling program. In this COBOL
system, the number of parameters passed is calculated by the number of parameters the calling
program actually receives.

C$PARAMSIZE
This routine returns the number of bytes actually passed by the caller for a particular parameter.
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Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "C$PARAMSIZE" 
    USING PARAM-NUM, 
    GIVING PARAM-SIZE

Parameters

PARAM-NUM numeric parameter This value is the ordinal position in the Procedure
Division's USING phrase of the parameter whose size
you want to know.

PARAM-SIZE any numeric data item This item receives the number of bytes in the data item
actually passed by the caller.

Description

This routine returns the actual size (in bytes) of a data item passed to the current program by its caller. You
pass the number (starting with 1) of the data item in the Procedure Division's USING phrase, and C
$PARAMSIZE will return the size of the corresponding item that was actually passed. This can be useful
for handling data items of unknown size.

For example, suppose that you wanted to write a routine that could convert any data item to upper-case,
up to 10000 bytes in size. This routine could look like this:

IDENTIFICATION DIVISION.
PROGRAM-ID.  MAKE-UPPERCASE.

DATA DIVISION.
WORKING-STORAGE SECTION.
77  PARAM-SIZE    PIC 9(5).

LINKAGE SECTION.
77  PASSED-ITEM   PIC X(10000).

PROCEDURE DIVISION USING PASSED-ITEM.
MAIN-LOGIC.
   CALL "C$PARAMSIZE" USING 1, GIVING PARAM-SIZE
   INSPECT PASSED-ITEM( 1 : PARAM-SIZE ) 
      CONVERTING "abcdefghijklmnopqrstuvwxyz" 
      TO "ABCDEFGHIJKLMNOPQRSTUVWXYZ"
  EXIT PROGRAM.

In this example, if you do not use C$PARAMSIZE, you have to pass a full 10000 bytes to this routine or
you get a memory usage error. By using C$PARAMSIZE and reference modification, only the memory
actually passed is referenced, and there is no error. C$PARAMSIZE works only when the program is a
called subroutine. It does not work with the "CALL RUN" form of the CALL verb.

If you pass a subitem of a linkage item in a CALL statement and the subprogram calls C$PARAMSIZE with
requesting the size of the parameter, it will get the size as described in the linkage section of the calling
program, unless that subitem is the first item of the linkage item. In that case, the size returned will be the
size of the original item.

Compatibility Issues

• This routine is not supported in managed COBOL.
• In this COBOL system, the size of the item as specified in the calling program is always returned.
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C$RERR
Returns extended file status information for the last I/O statement.

Syntax:
CALL "C$RERR" USING extend-stat [text-message, status-type]

Parameters:
extend-stat

PIC X(5) or larger

text-message
PIC X(n)

Note: This optional parameter is ignored in this COBOL system.

status-type
PIC 9

Note: This optional parameter is ignored in this COBOL system.

On Exit:

extend-stat Returns the extended file status caused by the last file I/O

Comments:

The statuses returned are listed in the file status table found in Appendix E of the ACUCOBOL-GT product
documentation. If the file status (first two characters) is 30, the remainder of the information is the
operating system's status code explaining what caused the error. On some systems, the operating system
requires more than two digits for its status codes. That is why the C$RERR routine may be passed a field
that is larger than four characters.

Whenever an error 30 occurs, the operating system's status value is returned in this extended field. The
number returned is a left-justified decimal value. If the receiving field is too small, the right-most digits are
returned. If the receiving field is too large, the excess characters are filled with spaces.

C$RERRNAME
Returns the name of the last file used in an I/O statement.

Use it in conjunction with C$RERR to diagnose file errors.

Syntax:
CALL "C$RERRNAME" USING file-name

Parameters:
file-name

PIC X(n)

On Exit:

file-name The name of the last file that was involved in an I/O statement.

Note: The filename is the one specified in the ASSIGN clause.

48 | Upgrading to Enterprise Developer for Eclipse



M$ALLOC (Dynamic Memory Routine)
Allocates a new area of dynamic memory.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "M$ALLOC" 
    USING ITEM-SIZE, MEM-ADDRESS

Parameters

ITEM-SIZE Numeric parameter This indicates the number of bytes to allocate. This must
be greater than zero.

MEM-ADDRESS USAGE POINTER This holds the return value, either the address of the
allocated memory or NULL if the allocation fails.

Comments

The maximum amount of memory you may allocate in one call depends on the host machine, but is at least
65260 bytes for all machines (providing that much memory is available). M$ALLOC adds some overhead
to each memory block allocated. This ranges between 4 and 16 bytes depending on the machine
architecture. Also, each operating system will typically add its own overhead. The debugger's U command
reports the amount of memory you have currently allocated via M$ALLOC. The overhead added by M
$ALLOC is included in the total shown, but the operating system's overhead is not. Memory allocated by M
$ALLOC is initialized to binary zeros (LOW VALUES).

If you try to allocate more memory than the environment can give you, M$ALLOC will return NULL, and no
memory will be allocated.

Compatibility Issues

None.

M$COPY (Dynamic Memory Routine)
Copies a region of memory from one location to another.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "M$COPY" 
    USING DEST-PTR, SRC-PTR, NUM-BYTES

Parameters

DEST-PTR USAGE POINTER Contains the address of the first byte of the destination
region.

SRC-PTR USAGE POINTER Contains the address of the first byte of the source
region.

NUM-BYTES Numeric parameter Indicates the size of the memory region to be copied.

Description

This routine copies NUM-BYTES from the address contained in SRC-PTR to the address contained in
DEST-PTR. Note that this routine is relatively dangerous to use. No boundary checking is performed to
ensure that the address range is valid, so memory access violations may result if you pass it incorrect data.
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This routine is functionally similar to the C$MEMCOPY routine except that parameters are passed by
reference instead of by value. For example, you can copy 10 bytes to DEST-PTR from the memory
address contained in SRC-PTR with:

     CALL "M$COPY" 
        USING DEST-PTR, SRC-PTR, 10

Compatibility Issues

None.

M$FILL (Dynamic Memory Routine)
Sets a region of memory to a constant value.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "M$FILL" 
    USING DEST-PTR, BYTE-VALUE, NUM-BYTES

Parameters

DEST-PTR USAGE POINTER Contains the address of the first byte of the region to be
filled.

BYTE-VALUE Alpha-numeric parameter Contains the value with which to fill the memory region.

NUM-BYTES Numeric parameter Indicates the size of the memory region.

Description

This routine fills NUM-BYTES with BYTE-VALUE starting at address DEST-PTR. The parameters are
passed BY REFERENCE. This routine does not do any boundary checking to make sure that the address
range is valid.

Compatibility Issues

None.

M$FREE (Dynamic Memory Routine)
Frees a previously allocated piece of memory.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "M$FREE" 
    USING MEM-ADDRESS

Parameter

MEM-ADDRESS USAGE POINTER Must point to a memory area previously allocated by M
$ALLOC.

Comments

Use M$FREE to release a memory block allocated by M$ALLOC. This memory is returned to the pool of
memory available for use by the runtime. On most operating systems, this memory is still associated with
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the runtime's process, so it cannot be used by any other processes. On a few systems, this memory may
be made available to the operating system for re-use by other processes.

It is an error to attempt to use a block of memory once it has been freed. It is also an error to free a block of
memory more than once or to free a memory address that has never been allocated. Any of these errors
can lead to memory access violations. The runtime attempts to detect these errors and avoid them, but it
cannot detect all such errors.

Compatibility Issues

None.

M$GET (Dynamic Memory Routine)
Retrieves data from an allocated memory block.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "M$GET" 
    USING MEM-ADDRESS, DATA-ITEM, DATA-SIZE, DATA-OFFSET

Parameters

MEM-ADDRESS USAGE POINTER Must point to a memory area previously allocated by M
$ALLOC.

DATA-ITEM Any data item Data from the memory block will be stored in this item.

DATA-SIZE Numeric parameter (optional) The number of bytes to move from the memory block. If
omitted, then the number of bytes is set to the size of the
memory block (excluding overhead bytes).

DATA-OFFSET Numeric parameter (optional) The location within the memory block from which to start
the move. The first location is position 1. If omitted, this
value defaults to 1.

Description

This routine retrieves data from the memory block at MEM-ADDRESS and stores it in DATA-ITEM.
Regardless of the value of DATA-SIZE, no bytes are copied from past the end of the memory block. Note
that the size of DATA-ITEM is not checked.

Compatibility Issues

None.

M$PUT (Dynamic Memory Routine)
Stores data in an allocated memory block.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "M$PUT" 
    USING MEM-ADDRESS, DATA-ITEM, DATA-SIZE, DATA-OFFSET
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Parameters

MEM-ADDRESS USAGE POINTER Must point to a memory area previously allocated by M
$ALLOC.

DATA-ITEM Any data item This is the data that will be stored in the memory block.

DATA-SIZE Numeric parameter (optional) The number of bytes to move to the memory block. If
omitted, then the number of bytes is set to the size of the
memory block (excluding overhead bytes).

DATA-OFFSET PIC 9(n), USAGE DISPLAY or COMP-4
(optional)

The location within the memory block from which to start
the move. The first location is position 1. If omitted, this
value defaults to 1.

Description

This routine copies DATA-ITEM into the memory pointed to by MEM-ADDRESS for DATA-SIZE bytes.
Regardless of the value of DATA-SIZE, no bytes are copied that exceed the size of the memory block at
MEM-ADDRESS.

Compatibility Issues

None.

RENAME
Renames a file.

Syntax:
CALL "RENAME"
   USING source-file, dest-file, [status,] [file-type]
   

Parameters:
source-file

PIC X(n)

dest-file
PIC X(n)

status
Any numeric type

file-type
PIC X

On Entry:
source-file

The path name of the file to be copied

dest-file
The path name of the destination file

file-type
The file organization of the source file. It must be one of: S (for sequential), R (for relative)
or I (for indexed).

This defaults to S if not specified.

52 | Upgrading to Enterprise Developer for Eclipse



On Exit:
status

Returns zero if the rename is successful, or non-zero if not.

Comments:

To obtain an extended file status code for this operation, define status as comp xx comp-x and follow the
example in Extended File Status Codes.

WIN$VERSION
Returns version information for Windows and Windows NT host platforms.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

This routine provides more information about the system than is returned by the ACCEPT FROM
SYSTEM-INFO statement.

Usage
CALL "WIN$VERSION" 
    USING WINVERSION-DATA

Parameters

WINVERSION-DATA Group item as follows: 01  WINVERSION-DATA. 
    03  WIN-MAJOR-VERSION     PIC X 
COMP-X. 
    03  WIN-MINOR-VERSION     PIC X 
COMP-X. 
    03  WIN-PLATFORM          PIC X 
COMP-X. 
        88  PLATFORM-WIN-31   VALUE 
1. 
        88  PLATFORM-WIN-95   VALUE 
2. 
        88  PLATFORM-WIN-9X   VALUE 
2. 
        88  PLATFORM-WIN-NT   VALUE 
3. 
    03  WIN-WORDSIZE          PIC X 
COMP-X. 
        88  WIN-WORDSIZE-16   VALUE 
1. 
        88  WIN-WORDSIZE-32   VALUE 
2. 
        88  WIN-WORDSIZE-64   VALUE 
3. 
    03  WIN-
BUILDNUMBER                 PIC X(4) 
COMP-X. 
    03  WIN-
CSDVERSION                  PIC 
X(128). 
    03  WIN-SERVICEPACK-
MAJOR           PIC X COMP-X. 
    03  WIN-SERVICEPACK-
MINOR           PIC X COMP-X. 
    03  WIN-
SUITEMASK                   PIC X(4) 
COMP-X. 
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    03  WIN-
PRODUCTTYPE                 PIC X 
COMP-X. 
        88 WIN-NT-
WORKSTATION           VALUE 1. 
        88 WIN-NT-DOMAIN-
CONTROLLER     VALUE 2. 
        88 WIN-NT-
SERVER                VALUE 3. 

WINVERSION-DATA is found in the COPY library
winvers.def.

Comments

Upon return from WIN$VERSION, all of the data elements contained in WINVERSION-DATA are filled in. If
you call WIN$VERSION and the host machine is not a Windows or Windows NT system, the fields are set
to zero.

The WINVERSION-DATA fields have the following meaning:

• WIN-MAJOR-VERSION - The major version number reported by Windows. See table below for possible
values.

• WIN-MINOR-VERSION - The minor version number reported by Windows. See table below for possible
values.

Windows Version WIN-MAJOR-VERSION WIN-MINOR-VERSION Other

Windows 98 4 10

Windows ME 4 90

Windows XP 5 1 Not applicable.

Windows XP Professional
x64 Edition

5 2 OSVERSIONINFOEX.wPro
ductType ==
VER_NT_WORKSTATION)
&&
(SYSTEM_INFO.wProcess
orArchitecture==PROCESS
OR_ARCHITECTURE_AM
D64

Windows NT 4 0

Windows 2000 5 0 Not applicable

Windows Vista 6 0 OSVERSIONINFOEX.wPro
ductType ==
VER_NT_WORKSTATION

Windows 7 6 1 OSVERSIONINFOEX.wPro
ductType ==
VER_NT_WORKSTATION

Windows Server 2008 R2 6 1 OSVERSIONINFOEX.wPro
ductType !=
VER_NT_WORKSTATION

Windows Server 2008 6 0 OSVERSIONINFOEX.wPro
ductType !=
VER_NT_WORKSTATION
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Windows Version WIN-MAJOR-VERSION WIN-MINOR-VERSION Other

Windows Server 2003 R2 5 2 GetSystemMetrics(SM_SE
RVERR2) != 0

Windows Home Sever 5 2 OSVERSIONINFOEX.wSuit
eMask &
VER_SUITE_WH_SERVE
R

Windows Server 2003 5 2 GetSystemMetrics(SM_SE
RVERR2) == 0

• WIN-PLATFORM - Provides a general description of the host system. If the host is Windows NT/
Windows 2000, the value is set to PLATFORM-WIN-NT. If the host is Windows 98, the value is set to
PLATFORM-WIN-9X.

• WIN-WORDSIZE - This item is set to WIN-WORDSIZE-32 for a 32-bit runtime.
• WIN-BUILDNUMBER - Identifies the build number of the operating system.
• WIN-CSDVERSION - Indicates the latest Service Pack installed on the system. If no Service Pack has

been installed the string is empty.
• WIN-SERVICEPACK-MAJOR - Indicates the major version number of the latest Service Pack installed

on the system. If no Service Pack has been installed the value is 0.
• WIN-SERVICEPACK-MINOR - Indicates the minor version number of the latest Service Pack installed

on the system. If no Service Pack has been installed the value is 0.
• WIN-SUITEMASK - This is a bit mask that identifies the product suites available on the system. Refer to

the operating system documentation for a list of possible values.
• WIN-PRODUCTTTYPE - Identifies additional information about the system.

Compatibility Issues

The copybook winvers.def is not available in this COBOL system.

The following fields are not supported in this COBOL system:

• WIN-BUILDNUMBER

• WIN-CSDVERSION

• WIN-SERVICEPACK-MAJOR

• WIN-SERVICEPACK-MINOR

• WIN-SUITEMASK

• WIN-PRODUCTTTYPE

These fields will return spaces or zeroes, as appropriate.

ACUCOBOL-GT Windowing Syntax
Your COBOL system provides some support for ACUCOBOL-GT windowing syntax that enables you to
draw lines and boxes on the terminal screen, and create virtual terminal windows on a physical terminal. All
ACCEPT and DISPLAY statements then act within the current window (except for ACCEPT format 1, 2, or
3 statements, DISPLAY format 1 statements, and DISPLAY WINDOW/LINE/BOX statements). The syntax
also enables underlying displays to be kept and restored.

Note: This functionality is supported in native COBOL only.

Windowing Syntax Summary

Your COBOL system includes the following syntax to support windowing:

• BEFORE TIME phrase in ACCEPT statement
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Format 5 of the ACCEPT statement has the BEFORE TIME phrase, which enables you to specify a
timeout period. If the user does not enter data during this period, the statement is terminated
automatically.

• DISPLAY WINDOW

DISPLAY WINDOW creates a terminal window (a rectangular region of the screen) and makes it the
current window. This is like a virtual terminal, in which screen positions used by subsequent ACCEPT/
DISPLAY statements are relative to the top left corner of the window.

• DISPLAY LINE

DISPLAY LINE enables you to draw lines on the terminal (real or virtual). The best mode available on
the terminal is used automatically. Used with the DISPLAY BOX statement, the DISPLAY LINE
statement enables you to draw forms on the terminal.

• DISPLAY BOX

DISPLAY BOX enables you to draw boxes on the terminal. The best mode available on the terminal is
used automatically. Used with the DISPLAY LINE statement, the DISPLAY BOX statement enables you
to draw forms on the terminal.

• CLOSE WINDOW

CLOSE WINDOW removes a window. If you specify the window as being a POP-UP window, the
underlying display can be restored.

Enabling Windowing Support

In order to use the windowing syntax, you must use the PREPROCESS"window1" Compiler directive.

You can specify this directive in one of two ways.

• In your source file, use the following line:

$SET preprocess"window1"

• From the command line, include the PREPROCESS"window1" directive:

Windows:

cobol prog.cbl preprocess"window1" color endp;

UNIX:

cob -C preprocess=window1 prog.cbl

The PREPROCESS "window1" directive must be the last Compiler directive apart from NOERRQ,
AUTOCLOSE or COLOR. If an error is encountered, the Compiler asks if you wish to continue, and waits
for your response. In order to disable this function, you must specify the NOERRQ directive after
PREPROCESS"window1".

Windowing Support Syntax

The following sections give details of the windowing syntax enabled by the PREPROCESS"window1"
directive.

The ACCEPT Statement

BEFORE TIME time-out

General Rules:

1. The BEFORE TIME phrase allows you to automatically terminate an ACCEPT statement after a certain
amount of time has passed. The timeout value specifies the time to wait in hundredths of a second. For
example, "BEFORE TIME 500" specifies a timer value of 5 seconds.

2. The user must enter data to the ACCEPT statement before the timer elapses. As soon as the user
starts entering data, the timer is canceled and the user may take as much time as desired to complete
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the entry. If the user does not enter any data before the timer elapses, then the ACCEPT statement
terminates.

The CLOSE WINDOW Statement

Format:
CLOSE WINDOW window-save-area

Syntax Rules:

1. window-save-area must be an elementary data item described with a PIC X(10) clause. It must have
been the object of a POP-UP AREA phrase in a DISPLAY WINDOW statement.

General Rules:

1. The CLOSE WINDOW statement is used to remove popup windows created by the POP-UP AREA
option of the DISPLAY WINDOW statement.

2. window-save-area must have been the object of a POP-UP phrase of a DISPLAY WINDOW statement
that has been executed in this run unit. Furthermore, since that execution, it must not have been the
object of a CLOSE WINDOW statement, nor can it have been modified by any other statement.
Violation of these rules causes undefined results.

3. The CLOSE WINDOW statement restores the contents of the terminal screen that was in the active
window when the corresponding DISPLAY WINDOW statement executed. In other words, the window
that was created by that DISPLAY WINDOW statement is removed from the screen and replaced by the
contents of the screen which were under that popup window.

4. The window that was active when the corresponding DISPLAY WINDOW statement executed becomes
the active window, thereby becoming the top window and overlaying any other windows that might be
present.

Comments:

The current window is selected by closing windows identified by their respective window-save-area data
items, as in the following example:

If five popup windows are created, a, b, c, d and e in that order:

• If d is closed, c becomes current.
• If b is then closed, a becomes current.
• If e is subsequently closed, c becomes current again.

The DISPLAY Statement

Format: for Format 1
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Format: for Format 2
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Format: for Format 3

 

 

Syntax Rules:

1. line-num is a numeric literal or data item that specifies the line position on the terminal screen. It must
be a non-negative integer.

2. col-num is a numeric literal or data item that specifies the column position on the terminal screen. It
must be a non-negative integer.

3. length is a numeric literal or data item that specifies the window-width, line-width or box-width in
character positions. It must be a non-negative integer.

4. height is a numeric literal or data item that specifies the number of lines in the window, line or box. It
must be a non-negative integer.

5. title is a non-numeric literal or alphanumeric data item.
6. save-area is an elementary data item described by a PIC X(10) clause.
7. COLUMN and COL are equivalent.
8. REVERSE and REVERSED and REVERSE-VIDEO are equivalent.
9. The COLOR phrase is supported only when the preprocessor directive COLOR is used. This adds

support for existing non-Micro Focus syntax.
10.Exactly one of the SIZE or LINES phrases must be specified for a Format 2 DISPLAY statement.
11.identifier-1, identifier-2, integer-1 and integer-2 must take a value in the range 0 through 7 as follows:

0 black

1 blue

2 green

3 cyan

4 red

5 magenta

6 brown or yellow
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7 white

12.identifier-3 and integer-3 must take a value which is obtained by adding together the appropriate values
from the following:

Color Foreground Background

Black 1 32

Blue 2 64

Green 3 96

Cyan 4 128

Red 5 160

Magenta 6 192

Brown 7 224

White 8 25

Note:

The foreground color values for use with the COLOR phrase are different from the standard Micro Focus
color values for FOREGROUND-COLOR, BACKGROUND-COLOR and so on.

In addition you can specify the following video attributes with the following values:

Reverse video 1024

Low intensity 2048

High intensity 4096

Underline 8192

Blink 16384

13.If a COLOR phrase is present at the same time as FOREGROUND-COLOR and/or BACKGROUND-
COLOR, then the colors defined in the COLOR phrase are ignored, but any non-color attributes are
actioned (where appropriate).

General Rules: for All Formats

1. The LINE and COLUMN phrases must specify a line or column on the physical screen.
2. On color systems, both the settings given in COLOR or FOREGROUND-COLOR and BACKGROUND-

COLOR and other attribute settings (for example blink) are used. On monochrome systems, all color
information supplied is ignored, and only other attribute settings used.

3. Not all combinations of attributes are supported on all systems. For example, on a standard DOS PC,
set to monochrome mode, REVERSE and UNDERLINE are mutually exclusive - only one of these
attributes is actioned.

General Rules: for DISPLAY WINDOW statement Format 1 (DISPLAY WINDOW)

1. The DISPLAY WINDOW statement creates and makes current a terminal window. The terminal window
is a rectangular region of your screen. Any ACCEPT or DISPLAY statements (apart from another
DISPLAY WINDOW/LINE/BOX or a Format 1, 2 or 3 ACCEPT or Format 1 DISPLAY as described in
your Language Reference) affect only the current window. Furthermore, line and column numbers for all
ACCEPT and DISPLAY statements (apart from another DISPLAY WINDOW/LINE/BOX or a Format 1,
2 or 3 ACCEPT or Format 1 DISPLAY as described in your Language Reference) are computed from
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the upper left-hand corner of the current window. That is, the current window defines a virtual terminal
screen which occupies some area of your physical screen.

2. The initial window is set to the entire screen.
3. The only way to change the current window is with another DISPLAY WINDOW statement or with the

CLOSE WINDOW statement.
4. The LINE NUMBER phrase sets the top line of the window. Line number one refers to the top line of the

screen. Line numbers are relative to the screen, and not to the current window.
5. If the LINE NUMBER phrase is not specified, is specified as zero, or is off the physical screen, the top

line of the screen is used.
6. The COLUMN NUMBER phrase sets the left-most column of the window. Column number one refers to

the left side of the screen. Column numbers are relative to the screen, and not to the current window.
7. If the COLUMN NUMBER phrase is not specified, is specified as zero, or is off the physical screen,

column number one is used.
8. The SIZE phrase sets the number of columns the window contains. If this causes the window to extend

past the right edge of the screen, the window's width extends off the screen.
9. If the SIZE phrase is not specified or is specified as zero, the window extends to the right edge of the

screen.
10.The LINES phrase sets the number of rows the window contains. If this causes the window to extend

past the bottom of the screen, the window extends off the screen.
11.If the LINES phrase is not specified or is specified as zero, the window extends to the bottom edge of

the screen.
12.When the ERASE phrase is specified, the window is cleared immediately after it is created. Otherwise

the window's contents are not changed. Clearing a window sets it to spaces.
13.The BOXED phrase causes a box to be drawn around the new window. The box is drawn outside the

window. Any portions of the box that lie off the screen are not drawn.
14.The terminal's line drawing set is used to draw the box. If the terminal does not have a line drawing set,

equivalent ASCII characters are used. If the POP-UP phrase is also specified, the box overlays any
other boxes on the screen. If this phrase is not specified, the box drawn is attached to any other boxes
it intersects. When a boxed non-popup window intersects a boxed popup window, if the popup window
is created first, when it is closed the points where the two window boxes intersected is not redrawn.
That is, intersection characters remain even though there is no longer an intersection.

15.The ERASE phrase is implied by the BOXED phrase.
16.The REVERSED phrase exchanges the window's foreground and background colors. This affects every

ACCEPT and DISPLAY statement in the new window.
17.The REVERSED phrase implies the ERASE phrase. This usually causes the entire window to be set to

reverse video spaces when it is initially created.
18.The SHADOW phrase causes the window to appear to float over the screen giving a three-dimensional

effect.
19.If the color value for either foreground or background is set to 0 in the COLOR field, then the

corresponding color of the default system attribute is used.
20.The TITLE phrase causes the title to be printed in the window's border. This has its effect only if the

BOXED phrase is also specified.
21.Titles can be placed in one of six positions in the border region: top left, top center, top right, bottom left,

bottom center and bottom right. If TOP or BOTTOM is not specified, TOP is used. If LEFT, CENTERED
or RIGHT is not specified, CENTERED is used.

22.The NO SCROLL phrase is treated as documentary only; the Windows preprocessor displays a
message confirming this.

23.The NO WRAP phrase is treated as documentary only; the Windows preprocessor displays a message
confirming this.

24.The POP-UP AREA phrase causes your COBOL system to save system information prior to creating
the new window. This information can be used by the CLOSE WINDOW statement to subsequently
remove the new window and restore the underlying windows. This gives a popup window.
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25.The save-area data item is filled in with system information. This data item must not be subsequently
modified in any way or results are undefined. It can be referenced in a CLOSE WINDOW statement to
restore an earlier window to the screen and re-establish that window as the current window.

General Rules: for DISPLAY LINE statement Format 2 (DISPLAY LINE)

1. The DISPLAY LINE statement enables you to draw vertical and horizontal lines in a machine- and
terminal-independent manner. The lines are drawn using the best mode available on the display device.
Used together with the DISPLAY BOX statement, this provides the ability to draw forms on your screen.
The DISPLAY LINE statement does not affect the positioning of full screen ACCEPT and DISPLAY
statements.

2. Lines are drawn so that when they intersect other lines on the screen, the appropriate intersection
character is used. This is done so that when the end of a line intersects another line, the appropriate
corner or three-way intersection is used.

3. If the SIZE phrase is specified, the line drawn is horizontal. The value of length gives the size of the line
in screen columns. If the LINES phrase is used instead, the line drawn is a vertical line and height
describes the number of screen rows to use.

4. Lines never wrap around or cause scrolling. If the LINES or SIZE phrase would cause the line to leave
the current window, the line is truncated at the edge of the window. If LINES or SIZE is zero, no line is
drawn.

5. The value of line-num gives the starting row of the line. The value of col-num gives the starting column.
Lines are always drawn to the right or downward as appropriate. line-num and col-num must specify a
position that is contained in the current window.

6. If the LINE NUMBER or COLUMN NUMBER phrases specify a point outside the physical screen, that
is, line-num = 0 or 24 (or your screen's maximum), or col-num = 0 or > 80, no line is drawn.

7. The TITLE phrase has effect only when drawing horizontal lines. When specified, title-string is printed in
part of the line.

8. The title can be printed near the right side, near the left side or in the center of the line depending on
the RIGHT, LEFT or CENTERED phrase specified. If none is specified, CENTERED is used.

9. The REVERSE phrase exchanges the foreground and background color of the line.

General Rules: for DISPLAY BOX statement Format 3 (DISPLAY BOX)

1. The DISPLAY BOX statement enables you to draw a box in a machine- and terminal-independent
manner. The boxes are drawn using the best mode available on the display device. If the lines used in
drawing a box intersect other lines already present on the screen, the appropriate intersection
characters are used. The DISPLAY BOX statement does not affect the positioning of full screen
ACCEPT and DISPLAY statements.

2. The location of the box is specified by providing the location of the upper-left corner. The size of the box
is specified by providing a height and a width.

3. If the LINE NUMBER or COLUMN NUMBER phrases specify a point outside the physical screen no box
is drawn.

4. The SIZE phrase specifies the width of the box. The LINES phrase specifies its height. If the SIZE
phrase is not specified, or zero, or such that the box would extend beyond the physical screen or the
edge of the window, the box extends to the right edge of the current window. If the LINES phrase is not
specified, or zero, or such that the box would extend beyond the physical screen, the box extends to the
bottom of the current window.

5. The REVERSE phrase operates in the same manner as it does for a DISPLAY WINDOW statement.
6. The TITLE phrase operates in the same manner as it does for the DISPLAY WINDOW statement.
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Windowing Restrictions

• This feature is not guaranteed to be intermediate code compatible, so you might need to recompile your
source code between product releases.

• When using the ACCEPT or DISPLAY statements with this windowing syntax, you must include the AT
LINE NUMBER syntax (see your Language Reference) or items do not appear in the windows.

• You should not use cobprintf() with these DISPLAY statements.
• You should not use COPY REPLACING or REPLACE statements.
• The windowing syntax is supported only for fixed format COBOL source.
• The following reserved words have been introduced by the windowing syntax, so you should avoid

specifying them as user-defined words:

BOX BOXED CENTERED COLOR (if COLOR directive used) POP-UP SCROLLSHADOW WINDOW
WRAP

• You should use only the ACCEPT and DISPLAY statements documented in your Language Reference
with this windowing syntax.

• When using windowing syntax, the ANS85 Compiler directive is implied. You must not unset this
directive either explicitly or implicitly.

• Alphanumeric literals must not be continued over the end of any line which includes a windowing
statement.

• Some syntax errors, for example, spelling PROCEDURE DIVISION incorrectly, are flagged, but might
result in spurious error messages for following source lines.

• Windowing syntax errors are serious errors, but are flagged in the form:

 xnnn-P******* 

• The -P cob flag should not be used with windowing syntax . You should instead use "-C list".
• Column 73 must not be used within source programs which use windowing syntax, as this column is

always treated as being set to a space character.
• The Compiler asks if you wish to continue after any error occurs. You can disable this function by using

the NOERRQ directive. You should not, however, use the NOERRQ directive when compiling from
within the Development Environment.

If no error occurred, or if an error occurred but you replied "no" to the question "do you wish to
continue", the Compiler returns a zero error return code.

• Each of the following statements must appear on a line by itself:

DISPLAY WINDOW DISPLAY BOX DISPLAY LINE CLOSE WINDOW EXIT PROGRAM
• The windowing subsystem is initialized automatically upon encountering the first windowing statement.
• If an application switches between using windowing syntax and other types of Accept/Display syntax, it

must close down the windowing system completely before starting to use other types of Accept/Display
syntax; otherwise the ACCEPT and DISPLAY statements may not have the desired effects.

You can create a subroutine to explicitly close the windowing system by compiling the following
subprogram:

$set preprocess "window1" autoclose
procedure division
para-1.
exit program.

You then call this subprogram before switching to another type of Accept/Display syntax. The
AUTOCLOSE preprocessor directive causes the EXIT PROGRAM statement to close down the
windowing system before exiting the subprogram. The windowing subsystem is reinitialized upon
encountering another windowing statement. Each time the windowing subsystem initializes, the
background screen and contents are redisplayed.

• When a window is active, or has been active in the run unit, use of the DISPLAY SPACES UPON CRT
statement clears the window to spaces but leaves attributes unchanged.
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Windowing Error Messages

The following errors might be encountered during preprocessing.

Unexpected numeric literal

Unexpected alphanumeric literal

Unsupported keyword or noise word

Unrecognized clause to DISPLAY WINDOW

Unrecognized clause to DISPLAY LINE

Unrecognized clause to DISPLAY BOX

Unrecognized clause to ACCEPT FROM SCREEN

This keyword has already been used

This keyword conflicts with another

This reserved word is used incorrectly

Wrongly formed or ordered clause with keyword

Error during preprocessing - no further details

Unknown COPY file specified

WINDOW1 preprocessor cannot handle free format

SCROLL/WRAP clause processed as comment The edit/compile/animate loop returns to an
incorrect line within your source program after
returning an error.

Windowing Supplementary Information

When the first windowing statement in your program is encountered the screen is redisplayed. This is
expected behavior and does not affect your program in any way.

Upgrading from RM/COBOL®

There are a number of settings in Enterprise Developer that are designed specifically to ensure that your
existing RM/COBOL source code can compile and run in Enterprise Developer.

Refer to the Compatibility with RM/COBOL section for guidance and best practice on moving your
applications to Enterprise Developer. It covers:

• Supported RM/COBOL features, including detailed information on support for data types and
subprograms.

• Syntactical differences between the two COBOL dialects, including workarounds or equivalent syntax
where applicable.

• Details on how to configure your applications to continue using your RM/COBOL data files.

Compatibility with RM/COBOL
Enterprise Developer provides compatibility with the RM/COBOL programming language:

This enables you to migrate programs from this environment. You can:

• Convert applications written in RM/COBOL to the Micro Focus COBOL language, and enhance them
using the advanced language and development features offered by Enterprise Developer.
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• Retain the use of the selected COBOL on some machine environments while moving to Enterprise
Developer on others. You might want to maintain a common set of source programs which are suitable
for all environments.

Note: Any error messages and numbers that are returned when you compile your program in
Enterprise Developer or when you execute the resulting code are different in the two environments.
This should present no problems, but is something of which you should be aware.

Converting RM/COBOL Applications
By default, this COBOL system already supports much of the RM/COBOL syntax and behavior. Additional
RM/COBOL-specific syntax that has been added for compatibility is documented in the section RM/COBOL
Syntax Support in your Language Reference.

You can also enable additional RM/COBOL behavior using certain Compiler directives. Using these
directives when you submit your RM/COBOL source programs to this COBOL system ensures that most of
the programs are accepted the first time they are submitted. There are still certain compatibility issues
between the two COBOL systems, which are detailed, with any possible workarounds, in the RM/COBOL
Conversion Issues section.

Compiler Directives for RM/COBOL Compatibility
You can set a number of Compiler directives in your RM/COBOL source programs that enable a program
to emulate RM/COBOL behavior.

The main directive that sets the majority of RM/COBOL behavior is DIALECT(RM).

Setting the DIALECT(RM) directive automatically sets additional Compiler directives, such as RM,
NOTRUNC, OLDINDEX, NOOPTIONAL-FILE, RETRYLOCK, ALIGN"2" and SEQUENTIAL"LINE". See the
topic RM Dialect Settings for full details of the directives set.

The system will also behave as if you had specified the following syntax:

sign trailing separate

for signed numeric data items, and:

lock mode is automatic

Previously, compatibility was achieved by compiling with the RM Compiler directive. The newer
DIALECT(RM) directive sets and extends the compatibility given by RM, and should be used for all new
migrations from RM/COBOL, unless you normally set the ANSI switch when you submit your RM/COBOL
source programs to the RM/COBOL system. If you do, set the RM"ANSI" directive when you compile your
programs.

We also recommend that you set the NOMF directive when you submit your RM/COBOL source programs
to this COBOL system. This ensures that only those words which are treated as reserved words under the
ANSI '74 COBOL standard are regarded as reserved words by this COBOL system.

Setting the NORM directive disables the syntax enabled when the RM directive was set, and automatically
resets the additional Compiler directives to NOSPZERO, TRUNC"ANSI", NOOLDINDEX, OPTIONAL-FILE,
NORETRYLOCK, ALIGN"8" and SEQUENTIAL"RECORD". Additionally, the system behaves as if you had
specified the syntax:

sign trailing included

for signed numeric data items, and:

lock mode is exclusive

for each file in the program which has no explicit locking syntax declared.

The final states of the additional directives set when you use the NORM directive are not necessarily the
same as their initial default states.
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Converting RM/COBOL Data Types

Types of Data

This COBOL system always allocates the same number of bytes to a data item as in the original program,
but might redefine its contents when it is converted. Therefore, you must be aware that if these items are
redefined, and the program logic expects to find a certain binary value in the redefinition, you might not
receive the behavior you are expecting at run time. At run time, this COBOL system might treat the ON
SIZE ERROR clause differently from the RM/COBOL system. See the chapter RM/COBOL Conversion
Issues for further details.

The following sections define how this COBOL system treats COMPUTATIONAL, COMPUTATIONAL-1
and COMPUTATIONAL-6 types of data.

COMPUTATIONAL (COMP) Data Types

This COBOL system treats any COMP data items in your RM/COBOL source program as the standard
Micro Focus COBOL DISPLAY format. The difference in the internal representation of such data in the two
systems is that this COBOL system always sets the most significant four bits of each byte to the value 3,
while the RM/COBOL system always sets such bits to the value 0.

For example, under the RM/COBOL system:

PIC 999 COMP VALUE 123

is held in three bytes as hexadecimal value 01 02 03

while under this COBOL system:

PIC 999 VALUE 123

is held in three bytes as hexadecimal value 31 32 33.

COMPUTATIONAL-1 (COMP-1) Data Types

For each data item declared as USAGE COMP-1 in your RM/COBOL source program, regardless of its
picture-string, this COBOL system allocates a 2-byte signed binary data item. This data item is capable of
holding a hexadecimal value in the range -32768 to +32767. That is, this COBOL system treats each RM/
COBOL USAGE COMP-1 data item as though it had a standard Micro Focus COBOL picture-string of
S9(4) COMP. See your Language Reference for details on the standard Micro Focus COBOL language.

PICTURE Character-strings

The maximum length of a PICTURE character-string in a record description is 20 characters. However, you
can overcome this limitation by splitting any PICTURE character-string which exceeds this limit into two,
and defining a FILLER item with a PICTURE character-string which corresponds to the size of the second
half of the original string.

COMPUTATIONAL-6 (COMP-6) Data Types

This COBOL system treats any COMP-6 data items in your RM/COBOL source program as the standard
Micro Focus COBOL COMP format. If, as a result of this, less data space is allocated to each item than
would be under the RM/COBOL system, this COBOL system pads the space with a byte containing a zero,
as shown in the following table:

RM COMP-6 PICTURE clause Bytes allocated when converting to
Micro Focus COBOL COMP
PICTURE clause

Number of bytes containing
leading zeros required to precede
COMP PICTURE clause

9(1) 1 NONE

9(2) 1 NONE
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RM COMP-6 PICTURE clause Bytes allocated when converting to
Micro Focus COBOL COMP
PICTURE clause

Number of bytes containing
leading zeros required to precede
COMP PICTURE clause

9(3) 2 NONE

9(4) 2 NONE

9(5) 3 NONE

9(6) 3 NONE

9(7) 4 NONE

9(8) 4 NONE

9(9) 5 NONE

9(10) 5 NONE

9(11) 5 1

9(12) 5 1

9(13) 6 1

9(14) 6 1

9(15) 7 1

9(16) 7 1

9(17) 8 1

9(18) 8 1

The padding byte precedes the converted field, and is therefore included in any redefinition of group fields
which contain the converted field. However, the padding byte would not be included if you redefined only
the converted field. If you wish to ensure that the padding byte is included in the redefinition of the
converted field, you must add a field at a higher level immediately before the converted field, and redefine
this new field instead.

COMP/COMPUTATIONAL Data

The RM/COBOL system represents COMP (or COMPUTATIONAL) data in packed decimal format with
one character per byte stored in each least significant four bits. The most significant half-byte always
contains zero. If the picture string specifies a signed representation, an additional byte is added to the least
significant end of the string: a negative value is represented by the hexadecimal value x"D", and a positive
value is represented by the hexadecimal value x"B".

Consider the following examples:

Value Picture Clause RM Representation (Hexadecimal)

1234 PIC 9(5) COMP 00 01 02 03 04

1234 PIC S9(5) COMP 00 01 02 03 04 0B

-1234 PIC S9(5) COMP 00 01 02 03 04 0D

You should converts COMP data fields into DISPLAY format, with sign trailing separate. This is compatible
with this COBOL system's treatment of RM/COBOL COMP fields in the source program when the RM
directive is set. If the data item is signed, the sign byte has the most significant half-byte set to
hexadecimal value 2.

After conversion, the examples above are represented as follows:
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Value Picture Clause This COBOL's Representation
(Hexadecimal)

1234 PIC 9(5) DISPLAY 30 31 32 33 34

1234 PIC S9(5) DISPLAY 30 31 32 33 34 2B

-1234 PIC S9(5) DISPLAY 30 31 32 33 34 2D

COMP-3/COMPUTATIONAL-3 Data

The RM/COBOL system represents COMP-3 data in packed decimal format with the least significant half-
byte holding the sign.

This sign half-byte contains the following values:

Field RM Sign half-byte value (Hexadecimal)

Unsigned F

Signed, Positive C or F

Signed, Negative D

Consider the following examples:

Value Picture Clause RM Representation (Hexadecimal)

1234 PIC 9(5) COMP-3 00 23 4F

1234 PIC S9(5) COMP-3 00 23 4C

-1234 PIC S9(5) COMP-3 00 23 4D

The only requirement for conversion is that the sign half-byte has to be changed for signed positive fields
to hexadecimal value C. The examples above are represented as follows:

Value Picture Clause This COBOL's Representation
(Hexadecimal)

1234 PIC 9(5) COMP-3 00 23 4F

1234 PIC S9(5) COMP-3 00 23 4C

-1234 PIC S9(5) COMP-3 00 23 4D

COMP-6/COMPUTATIONAL-6 Data

The RM/COBOL system holds COMP-6 data in a similar format to COMP-3 data, except there is no sign
half-byte. If a sign is indicated in the picture clause it is ignored and has no effect. The value held is always
positive.

Consider the following examples:

Value Picture Clause RM Representation (Hexadecimal)

1234 PIC 9(5) COMP-6 00 12 34

123456 PIC S9(6) COMP-6 12 34 56

In order to maintain the size and capacity of the data items, this COBOL system treats COMP-6 data items
as this COBOL's COMP format fields, and pads the field with binary zeros where necessary. The examples
above are represented as follows:
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Value Picture Clause This COBOL's Representation
(Hexadecimal)

1234 PIC 9(5) COMP-6 00 04 D2

123456 PIC S9(6) COMP-6 01 E2 40

The 9(5) COMP field is extended by one byte containing binary zero in order to maintain the size of the
original item. See the section COMPUTATIONAL-6 (COMP-6) Data Types in the chapter Compatibility with
RM/COBOL for details.

DISPLAY Data

You should be aware of the following differences between the representation of numeric DISPLAY format
data items, with sign INCLUDED, under the RM/COBOL system and this COBOL system:

• For positive values, this COBOL system does not encode a sign on the data, whereas the RM/COBOL
system increments the value of the most significant half-byte by one to denote a positive value.

• For negative values, this COBOL system increments the value of the most significant half-byte by four,
whereas the RM/COBOL system increments the value of the byte by twenty-five (that is, hexadecimal
19).

Use the SIGN directive with the EBCDIC, IBM or NCR parameters to maintain the same RM/COBOL
representations in this COBOL system.

When the DIALECT"RM" directive is set, a DISPLAY format data item with no sign clause associated is
treated by this system as though you had specified the SIGN TRAILING IS SEPARATE clause. However,
when the RM"ANSI" directive is set, the same data item is treated as though you had specified the SIGN
TRAILING IS INCLUDED clause. This is the default state for such data items in this COBOL system.

Consider the following examples:

Value Picture Clause RM/COBOL's Representation (Hexadecimal)

Leading Trailing

123 PIC 9(3) DISPLAY 31 32 33 31 32 33

123 PIC S9(3) DISPLAY 41 32 33 31 32 43

-123 PIC S9(3) DISPLAY 4A 32 33 31 32 4C

These examples are represented as follows:

Value Picture Clause This COBOL's Representation (Hexadecimal)

Leading Trailing

123 PIC 9(3) DISPLAY 31 32 33 31 32 33

123 PIC S9(3) DISPLAY 31 32 33 31 32 33

-123 PIC S9(3) DISPLAY 71 32 33 31 32 73

RM/COBOL Conversion Issues

The syntax of most RM/COBOL source programs when submitted to run on this COBOL system will be
accepted and run successfully. However, sometimes this COBOL system might reject some of the syntax
in your original RM/COBOL source program, or might cause your program to behave unexpectedly at run-
time.

This section contains the known problems which you may encounter. Hints are also given on how you can
either rectify the cause of such errors, or emulate the RM/COBOL type of behavior in this COBOL system.
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Producing Executable Code

The following section covers the known issues when submitting RM/COBOL source programs to this
COBOL system. Where possible, work-arounds and resolutions are also provided.

Perform Statements
PERFORM statements are not treated in the same way by both COBOL systems. This COBOL system
uses a stack-based perform handling system, while the RM/COBOL system associates a return address
with a specific procedure name.

As a result, under the RM/COBOL system, all end-points to PERFORM statements are always active until
they are used. However, under this system, only the end-point of the last PERFORM statement is active at
any one time.

You must set the PERFORM-TYPE directive with the RM parameter if this COBOL system is to emulate
the behavior of RM/COBOL PERFORM statements.

ACCEPT FROM CENTURY-DATE and FROM CENTURY-DAY
In Enterprise Developer, to use the FROM CENTURY-DATE and FROM CENTURY-DAY phrases with the
ACCEPT statement, set the RM Compiler directive.

Alternatively, use the following equivalent phrases with the ACCEPT statement:

• FROM DATE YYYYMMDD, which is the equivalent of FROM CENTURY-DATE.
• FROM DAY YYYYDDD, which is the equivalent of FROM CENTURY-DAY.

procedure division.
ACCEPT data-name-1 FROM DATE YYYYMMDD.
ACCEPT data-name-2 FROM DAY YYYYDDD.

Nested COPY statements with REPLACING phrase
In Enterprise Developer, you cannot specify text replacement as part of a nested COPY statement when
text replacement is already active as part of a COPY statement.

If you attempt to use COPY REPLACING in a file copied with a COPY REPLACING statement, an error
code COBCH0062 COPY replacement not supported is displayed on compilation.

Duplicate Paragraph-names

In Enterprise Developer, if you have duplicate paragraph-names, in different sections, and then call a
paragraph-name from outside its section, an error is produced unless you have explicitly referenced the
paragraph-name and its section. In RM/COBOL, by just calling the paragraph-name, it assumes you are
calling the next declaration of the paragraph-name found.

To ensure that references to duplicate paragraph-names are correctly resolved, you must qualify a
reference to a duplicate paragraph-name by adding the section-name in which it is declared.

Example

If your source code contains the following:

      .... 
      perform para-2. 
      .... 
 sect-1 section. 
      para-1. 
      .... 
      para-2. 
      .... 
 sect-2 section. 
      para-2. 
      ....
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RM/COBOL will resolve the reference to para-2 in the PERFORM statement by using the declaration of
para-2 in the sect-1 SECTION. In Enterprise Developer, however, you must qualify the reference to the
duplicate paragraph-name in your source code by using the PERFORM para-2 OF sect-1 statement.

Empty Groups
In Enterprise Developer, if you have any empty groups specified in your source code, you must set the
DIALECT"RM" Compiler directive.

Figurative Constants and the USING Phrase
In Enterprise Developer, to use figurative constants in the USING phrase of a CALL statement or as values
of level 78 constants, set the DIALECT"RM" Compiler directive.

Alternatively, the figurative constant can be replaced by the equivalent non-numeric literal, such as " " for
SPACE or "0" for ZERO.

File Not Found Errors
Enterprise Developer and RM/COBOL differ in the environment variables that they use to locate program
and data files.

If your source code produces a file not found error, ensure the correct paths are set in the correct
environment variables. In Enterprise Developer, set COBPATH to locate program files and COBDATA to
locate data files. The RUNPATH environment variable used in RM/COBOL, is not used in Enterprise
Developer.

Indexed File Error on Open
Enterprise Developer and RM/COBOL differ in how they handle record length fields and some data fields
when you open an RM/COBOL indexed file.

In Enterprise Developer, when you try to open an RM/COBOL indexed file, you may receive either a run-
time error COBRT161 Illegal intermediate code or a file status code 39 A conflict has been
detected between the fixed file attributes and the attributes specified for
that file in the program.

You must ensure that you read in the same size records that were created in RM/COBOL.

If the length of the file description does not match that which was processed in RM/COBOL, check the
following:

• In RM/COBOL, you can set the RECORD CONTAINS nn CHARACTERS clause to be a different length
than the actual length specified in the record description. If this clause is greater than the actual
description, you must pad the record description with filler bytes to match the RECORD CONTAINS
clause.

• If you have signed numeric display data in your file, Enterprise Developer will treat the sign as a
separate byte if you are using the RM directive without "ANSI" specified. If these fields are stored as
sign internal, you must use RM"ANSI" or do not use the RM directive at all.

Linkage Section in Main Program

In RM/COBOL, if the main program has a Linkage Section, it is initialized by the parameter passed on the
command line. In Enterprise Developer, you must use the command_line_linkage tunable to pass
parameters from the command line to the Linkage Section.

Library Routines
To use the RM/COBOL standard library routines that are available in Enterprise Developer, you must use
the 1024 calling convention.

C$Century
C$ConvertAnsiToOem
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C$ConvertOemToAnsi
C$DARG (only partially supported)
C$Delay
C$GetEnv
C$GetNativeCharset
C$LogicalAnd
C$LogicalComplement
C$LogicalOr
C$LogicalShiftLeft
C$LogicalShiftRight
C$LogicalXor
C$NARG
C$SetEnv
C$RERR
DELETE
RENAME

For more information on each library routine, see RM/COBOL Library Routines in the product Help.

Nested OCCURS DEPENDING Clauses
In Enterprise Developer, if you are using nested OCCURS DEPENDING clauses, you must set the
ODOSLIDE Compiler directive.

Numbering of Segments

In Enterprise Developer, you can only specify segment numbers in the range 0 to 99 inclusive, which
conforms to segment number limit specified in the ANS X3.23-1985 COBOL standard. In RM/COBOL, you
can specify segment numbers greater than 99.

If your source code has segment numbers greater than 99, recode the program. Make sure that any new
segment numbers you allocate do not clash with an already existing segment number. Segment numbers
between 0 and 49 inclusive are used by Enterprise Developer to indicate fixed portions of your object
program, while segment numbers 50 to 99 inclusive indicate independent segments.

For details on the use of segmentation and segment numbers in your source programs, see COBOL
Language Reference in the product Help.

Program Identification and Data Names

In Enterprise Developer, you cannot use the same name for the Program-ID and a data item in the
program; each name should be unique. RM/COBOL permits the name of the Program-ID paragraph and a
data item to share the same name.

REMARKS Paragraph
In Enterprise Developer, if your program uses the REMARKS paragraph in the Identification Division, you
must set the DIALECT"RM" Compiler directive.

Alternatively, mark the paragraph as comment lines.

Reserved Words
In Enterprise Developer, setting certain Compiler directives (such as RM and ANS85) activates certain
reserved words that you cannot use as names for your data items.

If you attempt to use a reserved word, you receive a COBCH0666 ("Reserved word used as data
name or unknown data description qualifier") COBOL syntax error.

To continue to use the reserved word as a data name, you can:
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• Use the REMOVE Compiler directive, to unreserve that particular keyword.
• Set the MFLEVEL Compiler directive to an appropriate level, to unreserve all keywords above that level.

See Compiler Directives in the product Help.

Example

Your RM/COBOL source program may contain the following lines of code:

     .... 
     03 sort   pic 99. 
     .... 
     move 1 to sort

If you submit this to Enterprise Developer, you will receive an error because the SORT verb is reserved.
However, if you specify the REMOVE"SORT" Compiler directive when you submit this source program,
you will not receive the error.

SAME AS Clause Not Available When Defining Data Structures
Enterprise Developer and RM/COBOL differ in the way that they allow you to reuse existing data
structures.

In Enterprise Developer, use the TYPEDEF clause to define your base data structure, and then use the
USAGE clause to create data structures of the same type.

data division.
working-storage section.
01 atype is typedef.
   03 var1 pic x(10) value "brown".
   03 var2 pic x(10) value "blue".
   03 var3 pic x(10) value SPACE.
01 a1 usage atype.
procedure division.
display var2 of a1.

The result of the display statement is blue.

The SAME AS clause used in RM/COBOL is not supported in Enterprise Developer.

Source Code in Columns 73 to 80
Enterprise Developer ignores any of the code in your source programs which lies within columns 73-80
inclusive.

Code in these columns could be the result of expanding TAB characters in your source program, instead of
standard TAB stops. If your source program contains TAB stops, convert them to spaces.

Undeclared Data Items in Clauses

In Enterprise Developer, you receive a COBCH0250 STATUS field data-name missing or
illegal error if a data item used in the File Status clause is not declared in the Working-Storage section.
In RM/COBOL, you do not have to declare the data item in Working Storage.

User-names Longer than 127 Bytes are Truncated
In RM/COBOL, you can specify user-names (data-names, procedure-names, program-names, etc) up to
240 characters long. In this COBOL system, user-names longer than 127 bytes in length are truncated and
a warning message is produced.

Solution:

Results may be affected if the truncated user-name is used with XML Extensions, to export or import XML
documents; therefore, we recommend that you keep user-names to 127 bytes or less.
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Running the Code

Once you have successfully submitted your RM/COBOL source program to this COBOL system and
produced executable code, you might encounter difficulties when you try to run this code under this
system. Alternatively, the code might run but you might find that its behavior under this COBOL system is
not exactly the same as under the RM/COBOL system. The following sections detail known areas of
difficulty you might encounter, and offer hints on how you can avoid them.

Table Bound Checking
If you try to run a program under this COBOL system which contains a subscript value greater than the
size of the table to which it refers, the run-time system will produce an error indicating this. Under the RM/
COBOL system, however, no such table bound checking is done.

Therefore, if you wish to disable table bound checking in this COBOL system, you must use the
NOBOUND directive.

If you use the NOBOUND directive when running intermediate code, you will be able to access data
beyond a table's bounds by using a subscript value greater than the table size. Use of the NOBOUND
directive when you are producing intermediate code will also disable bound checking when running
generated code. However, if you wish to access data beyond a table's bounds when running generated
code, you must also use the directive NOBOUNDOPT.

Note: When you use the NOBOUNDOPT directive, performance will be impaired.

ACCEPT Fields at the Edge of the Screen

If your program contains an ACCEPT statement for a numeric data item at a position on the screen where
the definition of the numeric data item would cause the ACCEPT field to go beyond the right-hand edge of
the screen, both COBOL systems will truncate the input value. In RM/COBOL, the input value will be
aligned into the ACCEPT field as an alphanumeric field, whereas in Enterprise Developer, the input value
is aligned as a numeric field.

Change the definition of the relevant PICTURE clause from numeric to alphanumeric. Alternatively, change
the PICTURE clause so that the field does not go beyond the edge of the screen.

Example

If your program contains the following statement:

ACCEPT data-item AT COLUMN NUMBER 75.

where data-item is a numeric data item defined as PIC 9(10), a value of 123456 entered into the
ACCEPT field will be held under Enterprise Developer as "0000123456". However, in RM/COBOL, the
value in the ACCEPT field would be held as "1234560000". To allow Enterprise Developer to emulate
the RM/COBOL behavior, alter the definition of the data item in your program to PIC X(10) or PIC 9(6).

COMPUTATIONAL-1 Data Items with a PICTURE other than S9(4)

In Enterprise Developer, a COMPUTATIONAL-1 data item is assumed to have a picture-string of S9(4). In
RM/COBOL, when a COMP-1 item is used as the source of a MOVE statement to an alphanumeric item,
the picture clause is preserved.

To produce the result you require, you must alter the definition of the target of the MOVE statement.

Example

The following source code causes TEST-RECORD to hold"99 " in RM/COBOL, but"0099" in Enterprise
Developer.

 01 test-record                pic x(4). 
 01 comp-1-item                pic 99 comp-1. 
 procedure division. 
    ...
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     move 99 to comp-1-item. 
     move comp-1-item to test-record.

To overcome this problem, alter the definition of TEST-RECORD as shown below:

 01 test-record.
     03 test-numeric-field     pic 99. 
     03 filler      pic xx. 
 01 comp-1-item                pic 99 comp-1. 
 procedure division. 
     ... 
    move 99 to comp-1-item. 
    move comp-1-item to test-numeric-field.

This avoids moving the COMPUTATIONAL-1 data item directly to an alphanumeric field.

Display of Input Data in Concealed ACCEPT Fields

If you have specified OFF and ECHO clauses for the same ACCEPT statement in your program, RM/
COBOL will conceal any data entered during input for that statement but on completion of input will display
the data. Enterprise Developer will not display the data for this ACCEPT statement once input has been
completed.

If you want to display the data input for an ACCEPT statement with the OFF and ECHO clauses specified,
you must add a DISPLAY statement after the ACCEPT statement.

Embedded Control Sequences in DISPLAY Statements
In Enterprise Developer, you cannot embedded control sequences within data items that you want to be
displayed.

Such characters are ignored at run time as they are hardware dependent.

Remove the control sequences from your source program and replace with the equivalent Micro Focus
COBOL syntax; for example, use the syntax WITH UNDERLINE to replace <left-arrow>]4m.

End of File Notification

The first time you unsuccessfully try to READ a sequential file in either COBOL system because you have
reached the end of the file, status key 1 in the FILE STATUS is set to 1 and status key 2 is set to 0. This
indicates that there is no next logical record. If you try to READ the same file again, without it either having
been previously closed and reopened, or it having been successfully started, Enterprise Developer
continues to indicate that there is no next logical record. However, if you try to READ the same file again
under RM/COBOL, status key 1 is set to 9 and status key 2 is set to 6.

A solution to the different file statuses returned for the circumstances given above will depend on the way
in which your source program is coded. We suggest that you include tests for the values 1 and 0 in status
key 1 and 2 of the file status, respectively, at the same time as you test for the values 9 and 6 in these
status keys.

Field Wrap-Around

If, when using binary data items (that is, RM/COBOL COMPUTATIONAL-1 format items) an arithmetic
operation gives a value which exceeds the capacity of the data item, and there is no ON SIZE ERROR
clause, Enterprise Developer wraps-around the value of the item. However, in RM/COBOL, the data item is
set to the limit of its capacity.

You should specify an ON SIZE ERROR clause to highlight such problems.
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Example

In RM/COBOL, the following lines of code result in the value +32767 being stored in the data item, CALC-
ITEM. However, Enterprise Developer sets CALC-ITEM to -32768:

01 calc-item         pic s9(4)  comp-1.

 procedure division. 
      .... 
     move 32767 to calc-item. 
     add 1 to calc-item.

File and Record Locking
Certain versions of RM/COBOL contain some software errors in the way in which locks for files and
records are handled. These errors do not occur in Enterprise Developer.

The errors fixed when upgrading to Enterprise Developer are:

• Indexed files do not detect or acquire locks if they are opened for output. This is regardless of whether
you specify the WITH LOCK phrase

• Relative and sequential files cannot be locked exclusively
• Files which are opened for input can detect record locks, although the RM/COBOL documentation

states that they cannot. When the RM directive is set in Enterprise Developer, record locks can still be
detected by files opened for input

• The first record in a sequential file opened for input-output is locked whenever any other record in that
file is locked

Initialization of Working Storage

Enterprise Developer initializes all working storage items without VALUE clauses to SPACES .The RM/
COBOL system initializes all working storage items to SPACES, unless you have placed numeric data
items between data items with VALUE clauses.

If this feature causes you any problems, because your program relies on the initial value given to the
system, add a VALUE clause with the appropriate value to your source program and resubmit it.

Example

The RM/COBOL system initializes the following group item to SPACES:

01 group-item. 
     03 item-1     pic x. 
     03 item-2     pic 99. 
     03 item-3     pic x.

However, if item-1 and item-3 have value clauses associated with them, the RM/COBOL system initializes
the second byte of item-2 to hexadecimal value 0 when item-2 is defined as USAGE COMP (signed or
unsigned) or USAGE DISPLAY (unsigned only).

Numeric Fields Containing Illegal Characters When Using a DEPENDING ON Phrase of an OCCURS
Clause

In Enterprise Developer, if you fail to initialize a numeric data item that is used in a DEPENDING ON
phrase of an OCCURS clause appropriately, a COBRT163 Illegal character in numeric field
error is displayed at run time, because the data item is initialized to SPACES if no value is specified. In
RM/COBOL, the data item is initialized to ZERO, and therefore, the error does not occur.

ON SIZE ERROR Phrase

In Enterprise Developer, the ON SIZE ERROR condition exists when the value resulting from an arithmetic
operation exceeds the capacity of the specified picture-string. In RM/COBOL, the ON SIZE ERROR
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condition exists when the value resulting from an arithmetic operation exceeds the capacity for the
associated data item.

Ensure that the capacity of any data items in your source programs is specified by a picture-string; for
example, COMPUTATIONAL-1 data items.

Open EXTEND of Nonexistent File

In Enterprise Developer, because setting the RM Compiler directive sets the NOOPTIONAL-FILE Compiler
directive, if you try to open a non-existent file for I-O or EXTEND the run-time system will give an error
message. For I-O, RM/COBOL does the same. However, for EXTEND, RM/COBOL creates the file and
opens it as if you had specified OUTPUT.

The following options are available:

• Add the keyword OPTIONAL to the SELECT statement. This makes Enterprise Developer create the
file and open it for OUTPUT

• Create the empty file before running your program
• Specify the OPTIONAL-FILE Compiler directive. This makes Enterprise Developer create the file and

open it for OUTPUT. However, the behavior with files opened for I-O will now differ from RM/COBOL

Printer Output is Written to Disk
By default, Enterprise Developer writes all output intended for a printer to disk.

To send output to a physical printer, you must map the filename using the dd_LPT1 environment variable
or, if your system supports the lp printer spooler, you should use:

dd_LPT1=">lp";export dd_LPT1

Redefinition of COMP or COMP6 Data Items

Enterprise Developer fully supports the size and capacity of RM/COBOL type COMPUTATIONAL and
COMPUTATIONAL-6 data items when the RM Compiler directive is set. However, the internal
representation of these data items in Enterprise Developer and in RM/COBOL is not the same. See the
chapter Compatibility with RM/COBOL in the product Help.

If this causes you problems, redefine these data items to take advantage of their internal format. MOVE the
data items concerned to other data items which are not defined as COMPUTATIONAL or
COMPUTATIONAL-6. Moving these data items converts the data automatically, overcoming any problems
you might have.

Example

The following source code is coded to take advantage of the internal representation of
COMPUTATIONAL-6 data items in RM/COBOL, and to analyze a date field:

 01 birthdate-1          pic 9(6) comp-6. 
 01 birthdate-2 redefines birthdate-1. 
     03 month-2         pic 99 comp-6. 
     03 day-2           pic 99 comp-6. 
     03 year-2          pic 99 comp-6. 
     ....

 procedure division. 
 start-up section. 
 para-1. 
     ....

     move 082462 to birthdate-1. 
     ....

     if year-2 = 62 
         display "records not available for 1962."
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Amend your source program to use the DISPLAY format instead of redefining COMPUTATIONAL-6 data
items, before submitting it to Enterprise Developer:

 01 birthdate-1          pic 9(6) comp-6. 
 01 birthdate-2 redefines birthdate-1. 
     03 month-2         pic 99 comp-6. 
     03 day-2           pic 99 comp-6. 
     03 year-2          pic 99 comp-6.

 01 birthdate-1a         pic 9(6). 
 01 birthdate-2a redefines birthdate-1a. 
     03 month-2a        pic 99. 
     03 day-2a          pic 99. 
     03 year-2a         pic 99. 
     ....

 procedure division. 
 start-up section. 
 para-1. 
     ....

     move 082462 to birthdate-1. 
     move birthdate-1 to birthdate-1a. 
     ....

     if year-2a = 62 
         display "records not available for 1962."

Screen Column Number Specification

Enterprise Developer permits you to specify screen column numbers up to and including 999, but RM/
COBOL permits you to specify column numbers greater than 999. If you try to run an RM/COBOL source
program containing a column number greater than 999 in Enterprise Developer, the column number is
truncated so that only the last three digits are used. If truncation of the column number occurs for an item
to be displayed on the screen, the position of that item on the screen in Enterprise Developer will differ
from its position in RM/COBOL.

Trailing Blanks in Line Sequential Files

Enterprise Developer always removes trailing blanks from line sequential records before writing the record.
RM/COBOL removes trailing blanks from such records only if the FD entry contains 01 level records of
different sizes. This will not cause you any problems when you run your converted RM/COBOL programs
in Enterprise Developer. However, you may receive errors at run time if any REWRITE operations on line
sequential files change the length of the records.

Change the file organization to sequential, or move an alternative padding character (for example, LOW-
VALUES) to the end of the record before it is written. This ensures that full-length records are written.

You also need to ensure that the T run-time switch is not set, as this might also change the size of the
record. See Run-time Switches in the product Help.

Undefined Results of MOVE and Arithmetic Operations
Enterprise Developer and RM/COBOL differ in the results of MOVE statements, arithmetic operations, and
comparisons that involve numeric and alphanumeric data items.

You can overcome most of these incompatibilities by redefining the data items involved, or by recoding the
comparisons. If you submit a program in Enterprise Developer containing an alphanumeric to numeric data
item MOVE statement, a warning message will be displayed indicating this.
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Example

If you submit a source program containing the following data items and procedural statements, the
specified test will fail at run time:

 01 numeric-field        pic 9(5). 
 procedure division. 
     move "abc" to numeric-field. 
     if numeric-field = "00abc" 
         ....

When the RM Compiler directive is set, Enterprise Developer partially emulates the behavior of RM/
COBOL for alphanumeric to numeric MOVEs by treating the numeric item as an alphanumeric item which
is right justified. However, the above example will still fail because RM/COBOL treats the literal ABC as
numeric, and places 00ABC in the numeric item. To make the statement run successfully in Enterprise
Developer, amend the test in the source program to:

     if numeric-field = " abc"

and resubmit the source program.

Using the Correct Calling Convention

We recommend that to use the RM/COBOL library routines provided in Enterprise Developer, you explicitly
set the 1024 call-convention in the CALL statement.

program-id. Program1.
Special-Names.
call-convention 1024 is RM.
...

procedure division.

call RM "SYSTEM" using "cmd.exe /c mkdir sys02".
   
goback.
end program Program1.

RM/COBOL Library Routines
The following RM/COBOL routines are available in this COBOL system.

C$Century
Updates your COBOL programs to handle the year 2000 issue.

Note: When calling this routine, ensure you are using the 1024 calling convention.

This library routine retrieves the first two digits of the current year.

Syntax:
CALL "C$Century" USING value-buffer

Parameters:
value-buffer

A two-byte data item with a format of either unsigned numeric display (NSU) or
alphanumeric display (ANS).

On Exit:

value-buffer The first two digits of the current year.
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Comments:

You can achieve the same result using the standard COBOL command ACCEPT data-name FROM DATE
YYYYMMDD and then referencing the data name.

C$ConvertAnsiToOem
Converts a buffer containing ANSI characters to a buffer containing the corresponding OEM characters.

When calling this routine, ensure you are using the 1024 calling convention.

This is supported on Windows only.

Syntax:
CALL "C$ConvertAnsiToOem" USING ansi-buffer, oem-buffer
[, char-count]

Parameters:
ansi-buffer

PIC X(n)

oem-buffer
PIC X(n)

char-count
PIC 9(n)

On Entry:

ansi-buffer The ANSI characters to be converted to OEM characters.

char-count The number of characters to be converted.

Note: If omitted or if the value is invalid, the actual size of the shorter of ansi-buffer
and oem-buffer is used.

On Exit:

oem-buffer The converted OEM characters.

C$ConvertOemToAnsi
Converts a buffer containing OEM characters to a buffer containing the corresponding ANSI characters.

Note: When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$ConvertOemToAnsi" USING oem-buffer, ansi-buffer
[, char-count]

Parameters:
oem-buffer

PIC X(n)

ansi-buffer
PIC X(n)

char-count
PIC 9(n)
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On Entry:

oem-buffer The OEM characters to be converted to ANSI characters.

char-count The number of characters to be converted.

Note: If omitted or if the value is invalid, the actual size of the shorter of ansi-buffer
and oem-buffer is used.

On Exit:

ansi-buffer The converted ANSI characters.

C$DARG
Returns information about a parameter passed in the USING or GIVING phrases of the CALL statement
that called a subprogram.

Restriction: This routine is supported in native COBOL only.

When calling this routine, ensure you are using the 1024 calling convention.

This information identifies the type and length of the argument and, when the argument is numeric or
numeric edited, the number of digits and scale factor for the argument.

Syntax:
CALL "C$DARG" USING argument-number, argument-description

Parameters:
argument-number

pic 9(n)

argument-description
01 ARGUMENT-DESCRIPTION.
    02 ARGUMENT-TYPE PIC 9(2) BINARY(2).
    02 ARGUMENT-LENGTH PIC 9(8) BINARY(4).
    02 ARGUMENT-DIGIT-COUNT PIC 9(2) BINARY(2).
    02 ARGUMENT-SCALE PIC S9(2) BINARY(2).
    02 ARGUMENT-POINTER POINTER.
    02 ARGUMENT-PICTURE POINTER.

On Entry:

argument-
number

The ordinal position of the argument in the USING phrase of the CALL statement. The
value zero returns the description of the GIVING phrase of the CALL statement.

On Exit:

argument-
description

Details of the passed parameter. Those details include:

argument-
type

The type of data item; see the table in the Comments section.

argument-
length

The number of character positions of the data item.

argument-
digit-count

The number of digits defined in the PICTURE character-string for an
argument that is a numeric or numeric edited data item as indicated by
the ARGUMENT-TYPE field value; otherwise, the value zero is
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returned for nonnumeric data items. The digit count for a numeric or
numeric edited data item does not include any positions defined by the
PICTURE symbol P, which represents a scaling position.

argument-
scale

The power of 10 scale factor (that is, the position of the implied or
actual decimal point) for an argument that is a numeric or numeric
edited data item as indicated by the ARGUMENT-TYPE field value;
otherwise, the value zero is returned for nonnumeric data items. If the
PICTURE symbol P was used in the description of the data item, the
absolute value of the ARGUMENTSCALE value will exceed the
ARGUMENT-DIGIT-COUNT value; in this case, a positive scale value
indicates an integer with P scaling positions on the right of the
PICTURE character-string and a negative scale value indicates a
fraction with P scaling positions on the left of the PICTURE character-
string

argument-
pointer

This parameter is not returned in this COBOL system.

argument-
picture

This parameter is not returned in this COBOL system.

Comments:

Use the C$NARG library routine to obtain the number of arguments passed in the CALL statement.

The actual number of arguments may exceed the number of formal arguments declared in the Procedure
Division header of the program that calls C$DARG. All of the actual arguments can be accessed using C
$DARG even though there is no formal argument name available for accessing the actual arguments
beyond the number of formal arguments.

The following table is used to indicate the data type specified in the ARGUMENT TYPE field:

Type Number RM/COBOL Data Type Type Number RM/COBOL Data Type

0 NSE 16 ANS

1 NSU 17 ANS (justified right)

2 NTS 18 ABS

3 NTC 19 ABS (justified right)

4 NLS 20 ANSE

5 NLC 21 ABSE

6 NCS 22 GRP (fixed length)

7 NCU 23 GRPV (variable length)

8 NPP 25 PTR

9 NPS 26 NBSN

10 NPU 27 NBUN

11 NBS 32 OMITTED

12 NBU

Restriction: Data type OMITTED (type number 32) is not supported in this COBOL system.
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C$Delay
Relinquishes the CPU for a length of time specified in seconds.

Note: When calling this routine, ensure you are using the 1024 calling convention.

This library routine allows other programs to run while the current program waits.

Syntax:
CALL "C$Delay" USING seconds

Parameters:
seconds

PIC 9(n)v999, where n is a digit from 1 to 7

On Entry:

seconds The number of seconds.

Comments:
The amount of delay is not exact. It depends upon the particular machine configuration and the load on the
machine.

C$GetEnv
Returns the value of an environment variable.

Note: When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$GetEnv" USING name, value [, return]

Parameters:
name

PIC X(n)

value
PIC X (n)

return
PIC 9(n) BINARY, where n can be a digit from 1 to 9

On Entry:

name The name of the environment variable.

On Exit:

value The value of the environment variable, returned from the call.

return The result code returned from the call: zero for success and non-zero for failure.

Comments:

On UNIX, environment variable names are case-sensitive. On Windows, environment variable names are
not case-sensitive.
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C$GetLastFileName
Retrieves the last filename used in a COBOL I/O statement (including OPEN and CLOSE).

Note: When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$GetLastFileName" USING filename

Parameters:
filename

PIC X(30)

On Exit:

filename The name of the filename used in the last I/O operation.

Comments:

For REWRITE and WRITE statements, the COBOL filename associated with the specified file record-name
is provided.

If the filename is longer than 30 characters, it is truncated to the right.

C$GetLastFileOp
Retrieves the last COBOL I/O operation performed.

Note: When calling this routine, ensure you are using the 1024 calling convention.

Use this library routine within a declarative procedure after an I/O error has occurred.

Syntax:
CALL "C$GetLastFileOp" USING operation

Parameters:
operation

PIC X(20)

On Exit:

operation The name of the last I/O operation performed. The valid operations returned are:

Close

CloseUnit

Delete

DeleteFile

DeleteRandom

Open

ReadNext

ReadPrevious

ReadRandom

Rewrite

RewriteRandom

Start

Unlock

Write

WriteRandom

Comments:

If the operation is longer than 20 characters, it is truncated to the right.
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If the value SPACES is returned that indicates that no operation is available.

C$GetNativeCharset
Retrieves information about the native character set in effect for the current run unit.

Note: When calling this routine, ensure you are using the 1024 calling convention.

The native character set specifies how non-numeric data is encoded in memory and on data files.

Syntax:
CALL "C$GetNativeCharset" USING charset-name [, codepage-number]

Parameters:
charset-name

PIC X(n)

codepage-number
PIC 9(n)

On Exit:

charset-name The name of the character set in use for the current run unit after the call.

Note: For Windows, the name will have a value of “ANSI” or “OEM”. On UNIX,
the value will be “NONE”.

codepage-
number

The codepage number of the character set in use for the current run unit after the call.

Note: For Windows, the codepage number will be the system ANSI codepage
number if charset-name contains “ANSI” and will be the system OEM codepage
number if charset-name contains “OEM”. On UNIX, the value will be 0.

Comments:

The native character set for a run unit on Windows can be either ANSI or OEM.

The native character set for a run unit on UNIX is determined by the locale settings for the system.

C$LogicalAnd
Performs a bitwise logical AND operation on two or more non-numeric or numeric operands.

When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$LogicalAnd"
[GIVING result]
 USING operand1 {operand2} ...

Parameters:
result

PIC 9(n)

operand1
A non-numeric or numeric operand

operand2, 3, etc
A non-numeric or numeric operand that must be of the same data type as operand1
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Note: If any non-numeric operand2 is shorter than operand1, it is assumed
to be padded on the right with binary zeroes.

On Entry:

operand1, 2, 3, etc Non-numeric or numeric operands, which must be of the same data type as
operand1.

On Exit:

result The result of the operation or operand1.

Comments:

For non-numeric USING operands, the bitwise logical AND of all the operands replaces the value of
operand1. The value of result is set to a non-zero value if any character of operand1 is non-zero after the
operation completes and zero otherwise.

For numeric USING operands, each operand is converted, if necessary, to a 32-bit binary integer. These
32-bit binary values are logically ANDed together. If the GIVING phrase is specified, the result of this
operation is stored in result and the value of operand1 is not modified. If the GIVING phrase is not
specified, the result of this operation is stored in operand1.

C$LogicalComplement
Performs a bitwise logical One's Complement operation on a non-numeric or numeric operand.

When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$LogicalComplement"
[GIVING result]
 USING operand

Parameters:
result

PIC 9(n)

operand
A non-numeric or numeric operand

On Entry:

operand A non-numeric or numeric operand.

On Exit:

result The result of the operation or operand.

Comments:

If operand refers to a non-numeric data item, the bitwise logical One’s Complement of the value of operand
replaces the value of operand. The value of result is set to a non-zero value if any character of operand is
non-zero after the operation completes and zero otherwise.

If operand refers to a numeric data item, the operand is converted, if necessary, to a 32-bit binary integer.
The 32-bit binary value is logically One’s Complemented. If the GIVING phrase is specified, the result of
this operation is stored in result and the value of operand is not modified. If the GIVING phrase is not
specified, the result of this operation is stored in operand.
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C$LogicalOr
Performs a bitwise logical OR operation on two or more non-numeric or numeric operands.

When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$LogicalOr"
    [GIVING result]
     USING operand1 {operand2} ...

Parameters:
result

PIC 9(n)

operand1
A non-numeric or numeric operand

operand2, 3, etc
A non-numeric or numeric operand that must be of the same data type as operand1

Note: If any non-numeric operand2 is shorter than operand1, it is assumed
to be padded on the right with binary zeroes.

On Entry:

operand1, 2, 3, etc Non-numeric or numeric operands, which must be of the same data type as
operand1.

On Exit:

result The result of the operation or operand1.

Comments:

For non-numeric USING operands, the bitwise logical inclusive OR of all the operands replaces the value
of operand1. The value of result is set to a non-zero value if any character of operand1 is non-zero after
the operation completes and zero otherwise.

For numeric USING operands, each operand is converted, if necessary, to a 32-bit binary integer. These
32-bit binary values are logically inclusive OR'd together. If the GIVING phrase is specified, the result of
this operation is stored in result and the value of operand1 is not modified. If the GIVING phrase is not
specified, the result of this operation is stored in operand1.

C$LogicalXor
Performs a bitwise logical exclusive OR operation on two or more non-numeric or numeric operands.

When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$LogicalXor"
    [GIVING result]
     USING operand1 {operand2} ...

Parameters:
result

PIC 9(n)

operand1
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A non-numeric or numeric operand

operand2, 3, etc
A non-numeric or numeric operand that must be of the same data type as operand1

Note: If any non-numeric operand2 is shorter than operand1, it is assumed
to be padded on the right with binary zeroes.

On Entry:

operand1, 2, 3, etc Non-numeric or numeric operands, which must be of the same data type as
operand1.

On Exit:

result The result of the operation or operand1.

Comments:

For non-numeric USING operands, the bitwise logical exclusive OR of all the operands replaces the value
of operand1. The value of result is set to a non-zero value if any character of operand1 is non-zero after
the operation completes and zero otherwise.

For numeric USING operands, each operand is converted, if necessary, to a 32-bit binary integer. These
32-bit binary values are logically exclusive OR'd together. If the GIVING phrase is specified, the result of
this operation is stored in result and the value of operand1 is not modified. If the GIVING phrase is not
specified, the result of this operation is stored in operand1.

C$LogicalShiftLeft
Performs a logical shift left operation on a non-numeric or numeric operand.

When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$LogicalShiftLeft"
[GIVING result]
 USING operand [shiftcount]

Parameters:
result

PIC 9(n)

operand
A non-numeric or numeric operand

shiftcount
PIC 9(n)

On Entry:

operand A non-numeric or numeric operand.

shiftcount The number of positions to shift during the operation.

On Exit:

result The result of the operation.
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Comments:

If operand refers to a non-numeric data item, the value of the data item is shifted left by the number of bit
positions specified by shiftcount. Any bits shifted off the left end are lost and zero-valued bits are shifted
into the right end. The value of result is set to a non-zero value if any character of operand is non-zero after
the operation completes and zero otherwise.

If operand refers to a numeric data item, the operand is converted, if necessary, to a 32-bit binary integer.
The 32-bit binary value is logically shifted left by the number of bit positions specified by shiftcount. If the
GIVING phrase is specified, the result of this operation is stored in result and the value of operand is not
modified. If the GIVING phrase is not specified, the result of this operation is stored in operand.

C$LogicalShiftRight
Performs a logical shift right operation on a non-numeric or numeric operand.

When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$LogicalShiftRight"
[GIVING result]
 USING operand [shiftcount]

Parameters:
result

PIC 9(n)

operand
A non-numeric or numeric operand

shiftcount
PIC 9(n)

On Entry:

operand A non-numeric or numeric operand.

shiftcount The number of positions to shift during the operation.

On Exit:

result The result of the operation.

Comments:

If operandrefers to a non-numeric data item, the value of the data item is shifted right by the number of bit
positions specified by shiftcount. Any bits shifted off the right end are lost and zero-valued bits are shifted
into the left end. The value of Result is set to a non-zero value if any character of operand is non-zero after
the operation completes and zero otherwise.

If operand refers to a numeric data item, the operand is converted, if necessary, to a 32-bit binary integer.
The 32-bit binary value is logically shifted right by the number of bit positions specified by shiftcount. If the
GIVING phrase is specified, the result of this operation is stored in result and the value of operand is not
modified. If the GIVING phrase is not specified, the result of this operation is stored in operand.
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C$NARG
Returns the number of parameters passed in the USING phrase of a CALL statement to the
subprogram that contains the call to C$NARG.

Arguments specified explicitly as OMITTED in the USING list of the CALL statement are included in the
count. The GIVING argument is not included in the count.

Note: When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$NARG" USING parameter-count

Parameters:
parameter-count

PIC 9(3) BINARY, COMP-4 or COMP-1

On Exit:

parameter-count The number of parameters passed.

C$SetEnv
Sets or clears the value of an environment variable.

Note: When calling this routine, ensure you are using the 1024 calling convention.

Setting the value of an environment variable with C$SetEnv updates the corresponding environment
variable immediately in the process space of the current run unit. Thus, when the RM/COBOL runtime
system uses environment variables for such actions as file access name resolution, the call to C$SetEnv
will have an immediate effect on that run unit.

Syntax:
CALL "C$SetEnv" USING name, value [, return]

Parameters:
name

PIC X(n)

value
PIC X(n)

return
PIC 9(n) BINARY, where n can be a digit from 1 to 9

On Entry:

name The name of the environment variable to set or clear.

value The value to which the environment variable is set. A value of SPACES indicates that the
environment variable should be deleted.

On Exit:

return The result code returned from the call: zero for success and non-zero for failure.
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Comments:

On UNIX, environment variable names are case-sensitive. On Windows, environment variable names are
not case-sensitive.

C$RERR
Returns the expanded I/O completion status, based on an error code received at run-time.

This routine returns either a four-character or an eleven-character extended status code, depending upon
the length of the data item specified in the USING phrase. This status is for the last attempted I/O
operation. The value returned conforms to ANSI COBOL 1985.

Syntax:
CALL "C$RERR" USING extended-status

Parameters:
extended-status

PIC X(4) or PIC X(11)

On Exit:

extended-status The data item into which the expanded I/O completion status is stored in ASCII
characters.

Comments:

If extended-status is four characters in length, the first two character positions contain the same digits as
would the file status data item on completion of the I/O operation. The last two character positions provide
additional information about the file status. In cases where only two digits for a status are shown, the last
two character positions will contain ASCII zeroes. Although most statuses contain only the decimal digits 0
to 9, note that the hexadecimal digits A to F are possible in some character positions. Refer to Appendix A:
Runtime Messages of the RM/COBOL User's Guide for a full list of status codes.

If extended-status is eleven characters in length, the first two character positions (positions one and two)
contain the same digits as would the file status data item on completion of the I/O operation. In cases
where Appendix A shows only two digits for a status, the remaining nine character positions contain ASCII
blanks. In cases where Appendix A shows four digits for a status, character position three contains an
ASCII comma, character positions four and five contain the last two digits of the status, and the remaining
six character positions contain ASCII blanks. For permanent errors, that is, when the first two digits are 30,
character position three contains an ASCII comma, character positions four and five contain a two-digit OS
code (see the table below), character position six contains an ASCII comma, and character positions seven
through eleven contain a five-digit, OS-specific error code. Refer to the Input/Output Errors section of the
RM/COBOL User's Guide.

Table 1: The two-digit OS codes

Code Description

00 Unknown OS error

01 File Manager Detected error

04 UNIX error

06 Btrieve error

10 Open File Manager error

11 C Library error
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Code Description

12 MS-Windows error

15 RM/InfoExpress Server error

16 RM/InfoExpress Client error

21 RM/InfoExpress WinSock error

DELETE
Deletes a file.

Note: When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "DELETE" USING file-name [exit-code]

Parameters:
file-name

PIC X(n)

exit-code
PIC S9(4) BINARY

On Entry:

file-name The full or relative pathname of the file to be deleted.

On Exit:

exit-code The exit code of the command upon return from the operating system: zero for success and
non-zero for failure.

Comments:

The values for the old-name parameter may be quoted with double quotes (") or single quotes ('). When
the name is quoted, the quotes are removed, but the name is not otherwise modified. If the name is not
quoted, the first control character terminates the name on Windows and the first white space character
terminates the name on UNIX. On Windows, trailing spaces are removed from unquoted names.

The old-name data item must be less than 1024 characters in length.

RENAME
Renames a file.

Note: When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "RENAME" USING old-name new-name [exit-code]

Parameters:
old-name

PIC X(n)

new-name
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PIC X(n)

exit-code
PIC S9(4) BINARY

On Entry:

old-name The source filename.

new-name The target filename.

On Exit:

exit-code The exit code of the command upon return from the operating system: zero for success and
non-zero for failure.

Comments:

The values for the old-name and new-name parameters may be quoted with double quotes (") or single
quotes ('). When the name is quoted, the quotes are removed, but the name is not otherwise modified. If
the name is not quoted, the first control character terminates the name on Windows and the first white
space character terminates the name on UNIX. On Windows, trailing spaces are removed from unquoted
names.

The old- and new-name data item must be less than 1024 characters in length.

SYSTEM
Executes an arbitrary operating system command.

Syntax:
CALL "SYSTEM" USING command-line [repaint-screen] [exit-code]

Parameters:
command-line

PIC X(n)

repaint-screen
This parameter is ignored in this COBOL system.

exit-code
This parameter is ignored in this COBOL system.

On Entry:

command-line An alphanumeric data item that contains the command line to be passed to the operating
system.

repaint-screen This parameter is ignored in this COBOL system.

On Exit:

exit-code This parameter is ignored in this COBOL system.

Comments:

The implementation of this library routine is identical to the existing Micro Focus version of SYSTEM.
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RM/COBOL File Handling
When you migrate your RM/COBOL applications to Enterprise Developer, you can continue to use the
same data files.

Alternatively, you can use a data migration tool to convert an RM/COBOL data file to Micro Focus format.
The data migration tool, RMMFDataMigration.exe, is available from the folder in which the product
samples are installed.

Configuring Access to RM/COBOL Indexed Data Files

To handle RM/COBOL indexed data files, you map a file to IDXFORMAT=21 in the File Handler
configuration file.

Within the configuration file, you can apply IDXFORMAT 21 to all files in a particular folder, all files with a
specific file extension, or a single file. See Format of the Configuration File for the tags that you can use for
the mapping, and the order in which settings in these tags are applied.

The order that the mapping is applied is important, as conflicting settings can be overwritten; for example,
the following excerpt of the configuration file sets all files in c:\files\rmfiles (Windows) or usr/
files/rmfiles (UNIX) to IDXFORMAT 21 and all files with a .DAT extension to IDXFORMAT 17:

Windows:
[FOLDER:C:\\files\\rmfiles]
IDXFORMAT=21

[*.DAT]
IDXFORMAT=17

UNIX:
[FOLDER:usr/files/rmfiles]
IDXFORMAT=21

[*.DAT]
IDXFORMAT=17

If there is a .DAT file in c:\files\rmfiles (Windows) or usr/files/rmfiles (UNIX), the mappings
are applied according to the type of tag. In the case above, mappings in the extension tag are applied after
mappings in the FOLDER tag, and so the .DAT file in that directory has an IDXFORMAT of 17.

By default, the File Handler handles all sequential and relative data files, but if you want to handle them
through the RM/COBOL file handler, use the INTEROP=RM configuration option; however, in cases where
the INTEROP and IDXFORMAT mappings conflict, the INTEROP setting will override IDXFORMAT for
your RM/COBOL indexed data files.

RM/COBOL File Status Codes

RM/COBOL file status codes take a 2-digit form in the file status variable, by combining the values of the
Status Key 1 and 2 columns, or a 4-character or 11-character extended file status code, which can be
retrieved using the C$RERR standard library routine.

To always return RM/COBOL file status codes:

• Set environment variable COBFSTATCONV to the RM/COBOL setting:

set COBFSTATCONV=rmstat

• Set the COBFSTATCONV Compiler directive.
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Status Key 1 Status Key 2 Extended File Status
Code

Description

3 5 9/013 File not found.

3 5 9/188 Filename too large.

3 7 9/035 Incorrect access
permission.

3 7 9/037 File access denied.

3 8 9/138 File is closed with lock -
cannot open.

3 8 9/210 File is closed with lock.

4 1 9/141 File already open - cannot
be opened.

4 2 9/142 File not open - cannot be
closed.

4 3 9/143 REWRITE/DELETE not
after successful READ

4 6 9/146 No current record defined
for sequential read.

4 7 9/147 Wrong open or access
mode for READ/ START.

4 8 9/148 Wrong open or access
mode for WRITE.

4 9 9/149 Wrong open or access
mode for REWRITE/
DELETE.

9 3 9/065 File locked.

9 8 9/071 Bad indexed file format.

9 8 9/139 Record length or key
inconsistent.

9 9 9/068 Record is locked.

Enabling CTF to Trace RM/COBOL Data Files
Enable the Micro Focus Consolidated Tracing Facility (CTF) to trace activity with your RM/COBOL data
files.

To enable CTF:

• Set the following environment variables:

set MFTRACE_CONFIG=ctf.cfg
set MFTRACE_LOGS=pathname   *> if not set, logs are stored in the current 
folder.

• In ctf.cfg, set the following:

mftrace.dest                = textfile
mftrace.level.mf.rts        = info
mftrace.comp.mf.rts#eprintf = true

• Set the following environment variable:

set A_CONFIG=rmfm.cfg    *> rmfm is your RMFM configuration file
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• In rmfm.cfg, set the following:

DEFAULT_FILESYSTEM RMFM
FILE_TRACE 3   *> values 0-9 set amount of activity traced.

When you run your program, a log-file is produced that includes the activity with the RM/COBOL data files.

For more information on CTF, see Introduction to the Consolidated Tracing Facility.

Compatibility with XML Extensions
Note: This functionality is supported in native COBOL only.

XML Extensions has many capabilities. The major features support the ability to import and export XML
documents to and from COBOL working storage. Specifically, XML Extensions allows data to be imported
from an XML document by converting data elements (as necessary) and storing the results into a matching
COBOL data structure. Similarly, data is exported from a COBOL data structure by converting the COBOL
data elements (as necessary) and storing the results in an XML document.

For more information about XML Extensions, refer to the XML Extensions User's Guide, available from the
RM/COBOL product documentation set, in the SupportLine section of the Micro Focus Web site.

For RM/COBOL users that utilize XML Extensions, here is a summary of compatibility issues that you need
to be aware of when working in this COBOL system. Refer to this list and the RM/COBOL Conversion
Issues list in the Compatibility with RM/COBOL section

Click a summary title for a fuller explanation and workaround, where possible.

Additional Parameter Required with XML Extensions Processing Statements
In statements that use a Document Pointer parameter, you are also required to pass an additional
Document Length parameter.

When using XML Extensions processing statements, each Document Pointer parameter must be
immediately followed by a Document Length parameter. This applies to the following statements:

• XML EXPORT TEXT
• XML IMPORT TEXT
• XML TEST WELLFORMED-TEXT
• XML VALIDATE TEXT
• XML GET TEXT
• XML PUT TEXT
• XML TRANSFORM TEXT

Note: XML FREE TEXT does not require that you use the Document Length parameter.

Solution:

Ensure that the Document Length parameter (MY-DOCUMENT-LENGTH) is specified immediately
following the Document Pointer parameter (MY-DOCUMENT-POINTER) when calling an XML Extensions
processing statement:

When the statement is outputting data, the statement will set MY-DOCUMENT-LENGTH:

XML EXPORT TEXT
    MY-DATA-ITEM
    MY-DOCUMENT-POINTER
    MY-DOCUMENT-LENGTH
    "MY-MODEL-FILE".
IF NOT XML-OK GO TO Z.

96 | Upgrading to Enterprise Developer for Eclipse



When the statement is inputting data, you must set MY-DOCUMENT-LENGTH before the statement is
processed:

XML IMPORT TEXT
    MY-DATA-ITEM
    MY-DOCUMENT-POINTER
    MY-DOCUMENT-LENGTH            *> The size of the data item pointed to by 
MY-DOCUMENT-POINTER.
    "MY-MODEL-FILE".
IF NOT XML-OK GO TO Z. 

COBOL programs using BIS
Programs in this COBOL system that are used with the Xcentrisity Business Information Server (BIS) must
end with the GOBACK statement, not the STOP RUN statement. Also, messages for the BIS trace log
must be generated by calling the B$Trace library program, not the DISPLAY statement.

Programs that are used with the BIS must not use the STOP RUN statement, as this will terminate the MF
run-time prematurely and the BIS will be unable to process any further web service requests.

In RM/COBOL, programs that are used with BIS capture the output of a DISPLAY statement and place it in
the BIS trace log. In this COBOL system, to place messages in the BIS trace log, use the B$Trace library
routine.

Solutions:

To ensure that programs used with the BIS do not prematurely terminate the MF run-time, use the
GOBACK statement in those programs.

To place messages in the BIS trace log, call the B$Trace library program, using the same identifiers or
literals, but not figurative constants, that you would use in a DISPLAY statement.

Note: Numeric data items can be of any data type and are converted to a numeric string by B$Trace.

call "B$Trace" using "Log message: " MyMessage " " MyStatus.

Conflicts Between Model File-names and XML Data Files
In this COBOL system, model file-names, as created by the compiler, are of the form program-name.xml.
You should ensure your XML data files do not share the same name as this, to avoid any conflicts.

In this COBOL system, if the ModelFileName#DataName parameter does not include a hash, it is always
treated as a model data-name, and the model file-name is assumed to be program-name.xml for the
program (or one of its callers) that executed an XML Extensions export or import statement. With this in
mind, if you do not explicitly set a model file-name, you should ensure that your XML data files do not
share the same name as your COBOL programs when performing import and export XML Extensions
statements.

Solution:

To avoid conflicts between model file-names and XML data file-names, do one of the following:

• Ensure you set the DocumentName parameter in your import and export statements to a name other
than your COBOL program name.

• If you want to keep your XML data file-names the same as the program-name, rename the model file-
name after compilation and specify the new name in the value of the ModelFileDataName parameter
before the hash, separating it from the ModelDataName.

When using the second technique, it is recommended that the compilation be done with a script that
includes the renaming command, to avoid forgetting this step.
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Notes:

In RM/COBOL, you can use the environment variable RM_MISSING_HASH to determine the meaning of
the ModelFileDataName parameter when the hash is omitted. In this COBOL system, the environment
variable is not supported.

Also, RM/COBOL v12 and later generally did not use model files because the model was embedded in the
object program file; this COBOL system is more like RM/COBOL v11 and earlier, which always used model
files. Thus, care must be taken to distribute model files with applications that use XML Extensions.

Creating an XML Model File
To create an XML model file for use with XML Extensions, compile your application with the XMLGEN
Compiler directive.

By default, this creates an XML model file, named output-name.xml, that includes data descriptions
from the File Section of your code. This file is created in the project's root directory.

Note: The output-name defaults to the root name of your program source file, but you can change it
in the project's properties.

There are two parameters to this directive that enable you to alter the default behavior:

To change the location of the model file, specify:

XMLGEN(pathname)

where pathname is the absolute or relative path name of the .xml file, which is prefixed to the default file
name. You can also use an environment variable, which will resolve to a path name during runtime:

XMLGEN($myXML/)

where myXML is an environment variable set to the absolute or relative path name of the .xml file, which
is prefixed to the default file name.

To include data descriptions from the Working-storage section in the model file, specify:

XMLGEN(ws)

See Restricted data items with XML Extensions for a workaround to include data descriptions from other
Data Division sections of your source code.

When using both parameters in your program, ensure you set XMLGEN(pathname) before you set
XMLGEN(ws); otherwise, XMLGEN(pathname) suppresses the XMLGEN(ws) option, which results in only
File Section data descriptions in the XML file.

Displaying the Status of XML Extensions Statements
In this COBOL system, use the XML-Status-Edited data item to display the status result of an XML
Extensions statement execution.

In RM/COBOL, XML-Status, the data item used to display the status result of an XML Extensions
statement execution, is defined as Display Usage. In this COBOL system, XML-Status is defined as:

03 XML-Status        PIC S9(4) COMP-5.

Therefore, an additional declaration is made in lixmldef.cpy, so that you can easily use the status result in
your code:

03 XML-Status-Edited        PIC +9(4).

When an XML Extensions statement is executed, the value of XML-Status-Edited is not set, so you need
move XML-Status to XML-Status-Edited before you can use the result.

Importing and Exporting Ambiguous Data-names

In RM/COBOL, if you attempt to export an ambiguous data-item to a model file, an error is produced. If you
attempt to import to an ambiguous data-item, the data is placed in the first occurrence of the named data-
item.
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In this COBOL system, if you attempt to export an ambiguous data-item to a model file, a warning message
is produced and the first occurrence of the named data-item is exported. Similarly, If you attempt to import
to an ambiguous data-item, a warning message is displayed and the data is placed in the first occurrence
of the named data-item.

Example:

01 Group01.
    02 GroupA.
      03 NumItem     PIC s9(5).
      03 StrItem     PIC X(5).
        02 GroupB.
          03 NumItem  PIC s9(5).
          03 StrItem  PIC X(5).

--------------------------------
<StrItem> ABCDE </StrItem>   *> this produces a warning and 
updates StrItem in GroupA

<GroupB><StrItem> ABCDE </StrItem></GroupB>  *> this updates 
StrItem in GroupB

Invalid Characters in Condition Names
In this COBOL system, if you use mark-up characters as values for condition names, this can produce
invalid XML when exporting code using XML Extensions.

Mark-up characters, such as "<", ">" or "&" used in the values for condition names will produce invalid
model files when using XML Extensions. The model files will cause parse errors when loaded by XML
Extensions using the XML parser; XML Extensions will report the parse error and be unable to perform the
requested export or import.

88 cond-name VALUE "<br/>".

Solution:

In this COBOL system, you must modify the COBOL source code, to eliminate mark-up characters in
condition-name values.

Restricted data items with XML Extensions
In this COBOL system, you cannot use data items described in any section other than the File or Working
Storage Sections, as model data names.

To export data items from or import XML data into this COBOL system, use the XMLGEN Compiler
directive to create a model file, for use with XML Extensions.

The model data names specified in the model file are determined by XMLGEN:

• XMLGEN with no parameter specified produces model data names for data items/structures in the File
Section only.

• XMLGEN(ws) produces model data names for data items/structures in the Working Storage Section
only.

Important: Data items/structures described in the Linkage Section, Communication Section, Local-
Storage Section and Thread-Local-Storage Section cannot be used as model data names in a model
file.

Solution:

Using a copybook containing your data items, compile a dummy program that copies the descriptions into
the Working Storage section, and then use the XMLGEN(ws) Compiler directive to create a model file
containing the required data items.

Upgrading to Enterprise Developer for Eclipse | 99



Notes:

The data items used at runtime when the model file is used can be in any section of the data division.

Unable to Use Data Items Declared in Nested Programs
In this COBOL system, you cannot use data items declared in nested programs, as model data-names.

Solution:

Using a copybook containing your data items, compile a dummy program that copies the descriptions into
the Working Storage section of your top-level program, and then use the XMLGEN(ws) Compiler directive
to create a model file containing the required data items.

User-names Longer than 127 Bytes are Truncated
In RM/COBOL, you can specify user-names (data-names, procedure-names, program-names, etc) up to
240 characters long. In this COBOL system, user-names longer than 127 bytes in length are truncated and
a warning message is produced.

Solution:

Results may be affected if the truncated user-name is used with XML Extensions, to export or import XML
documents; therefore, we recommend that you keep user-names to 127 bytes or less.

Using the Correct Calling Convention

In this COBOL system, XML Extensions uses the standard COBOL calling convention. If your programs
are also using the standard library routines implemented for RM/COBOL compatibility, you need to be
aware that these are called using the 1024 calling convention.

Solution:

Generally, you should explicitly use the 1024 calling convention when calling your RM/COBOL standard
library routines, but if you are using the DEFAULTCALLS Compiler directive to set this calling convention,
you will need to override it when calling to XML Extensions.

Native COBOL compared with managed COBOL
Native COBOL and managed COBOL differ in how they compile and how the run-time management
services, such as security, threading and memory management are provided.

Managed COBOL for JVM compiles to Java bytecode, and native COBOL compiles to machine code. Both
managed and native COBOL can run on any platform when compiled.

For JVM managed code, the management services are provided by JVM. For native COBOL, the
management services are available in the operating system, and your code has to call the appropriate
services depending on the operating system. The management services enable seamless interoperation of
COBOL programs with programs in other JVM languages.

Building native and managed COBOL applications

You use the IDE to develop, compile and debug your applications, for both native and managed code. You
can write new COBOL code or you can recompile existing COBOL as managed or native code, potentially
without any code changes.

You can deploy and further debug the application under the run-time system provided by Enterprise
Server. JVM COBOL applications are deployed to the platform running the JVM.
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Customer Feedback
We welcome your feedback regarding Micro Focus documentation.

Submit feedback regarding this Help

Click the above link to email your comments to Micro Focus.
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